Applications Handbook for the Palm III™ Organizer
Copyright

Copyright © 1998 3Com Corporation or its subsidiaries. All rights reserved. 3Com, the 3Com logo, Palm Computing, Graffiti and HotSync are registered trademarks, and PalmPilot, Palm III, Palm OS, Palm, the Palm Computing platform logo, the PalmPilot logo and the Palm III logo are trademarks of Palm Computing Inc., 3Com Corporation or its subsidiaries. Other product and brand names may be trademarks or registered trademarks of their respective owners. This product is not manufactured by Pilot Corporation or Pilot Corporation of America, manufacturers and distributors of writing instruments.

Disclaimer and Limitation of Liability

3Com Corporation and its subsidiaries assume no responsibility for any damage or loss resulting from the use of this handbook.

3Com Corporation and its subsidiaries assume no responsibility for any loss or claims by third parties which may arise through the use of this software. 3Com Corporation and its subsidiaries assume no responsibility for any damage or loss caused by deletion of data as a result of malfunction, dead battery or repairs. Be sure to make backup copies of all important data on other media to protect against data loss.

Important: Please read the “3Com End User Software License Agreement” contained in the Basic Handbook for the Palm III Organizer before using the accompanying software program(s). Using any part of the software indicates that you accept the terms of the 3Com End User Software License Agreement.

3.5" Software Diskettes Available

Palm Desktop software is supplied on a CD-ROM disc. If you do not have access to a CD-ROM drive for your computer, you may obtain 3.5” diskettes. See “Technical Support, Service and Repair” in the Basic Handbook for the Palm III Organizer for the phone number to obtain these diskettes, or complete and mail (or fax) the diskette offer card supplied in the Palm III organizer product package.
# Contents

**Chapter 1: Address Book**  
Getting Started With Address Book Entries ........................................2  
Working With Address Book Entries ....................................................5  
Address Book Menu Commands ..........................................................10  

**Chapter 2: Calculator**  
Using the Calculator Screen ..............................................................13  
Calculator Menu Commands ...............................................................15  

**Chapter 3: Date Book**  
Scheduling an Event ...........................................................................18  
Rescheduling an Event ........................................................................22  
Setting an Alarm for an Event ..............................................................22  
Scheduling Repeating Events ...............................................................23  
Marking a Private Event ......................................................................25  
Deleting an Event ................................................................................25  
Changing the Date Book View .............................................................26  
Date Book Menu Commands .................................................................29  

**Chapter 4: Expense**  
Creating an Expense Item ....................................................................33  
Entering Receipt Details ........................................................................35  
Show Options .........................................................................................38  
Transferring Your Data to Microsoft Excel ........................................39  
Expense Menu Commands ....................................................................44  

**Chapter 5: HotSync®**  
The HotSync Process and the HotSync Manager ..............................47  
Performing a HotSync Operation for the First Time ............................48  
Conducting a Local HotSync Operation ..............................................50  
Selecting HotSync Setup Options ......................................................50  
Customizing HotSync Application Settings ........................................54  
Conducting a HotSync Operation via Modem .....................................55  
Conducting HotSync Operation via a Network ....................................59  
Creating a User Profile .......................................................................59  
Using File Link ....................................................................................61  

**Chapter 6: Mail**  
Setting Up Mail on the Desktop .........................................................63  
Synchronizing Mail with your E-Mail Application ..............................66  
Opening Mail on your Palm III organizer ..........................................66  
Viewing Messages ................................................................................66  
Creating Messages ..............................................................................68
Looking Up an Address ............................................................... 70
Adding Message Details ............................................................ 72
Sending Messages ....................................................................... 75
Editing an Unsent Message ....................................................... 76
Draft Messages .......................................................................... 77
Filing a Message ........................................................................ 78
Deleting Messages ...................................................................... 78
Message List Options ............................................................... 80
HotSync Options ....................................................................... 82
Creating Special Filters ............................................................ 84
Defining Filter Strings .............................................................. 86
High-Priority Messages ............................................................. 88
Truncating Messages ................................................................. 88
Mail Menu Commands .............................................................. 89

Chapter 7: Memo Pad
  Working With Memos ............................................................ 94
  Arranging Memos .................................................................... 95
  Marking a Private Memo ......................................................... 96
  Deleting a Memo ...................................................................... 97
  Memo Pad Menu Commands .................................................. 98

Chapter 8: Preferences
  Buttons Preferences ............................................................... 102
  Digitizer Preferences ............................................................. 105
  Formats Preferences ............................................................. 105
  General Preferences ............................................................. 106
  Modem Preferences ............................................................. 109
  Network Preferences and Palm TCP/IP Software .................... 110
  Owner Preferences ............................................................... 124
  ShortCuts Preferences .......................................................... 125

Chapter 9: Security
  Assigning a Password ........................................................... 128
  Hiding Private Entries .......................................................... 129
  Showing Private Entries ....................................................... 130
  Locking Your Palm III Organizer ............................................ 130
  Changing or Deleting a Password .......................................... 131
  Recovering from a Forgotten Password .................................. 132
Chapter 10: To Do List
  Opening the To Do List .................................................................133
  Working With To Do Items ............................................................134
  To Do Item Details .......................................................................136
  Deleting a To Do Item ...................................................................137
  To Do Show Options .....................................................................138
  To Do List Menu Commands .......................................................139

Appendix A: Expense Templates
  Expense Templates ......................................................................143

Appendix B: Creating a Custom Expense Report
  About Mapping Tables ...............................................................147
  Customizing Existing Sample Templates .................................148
  Determining the Layout of the Expense Report .......................149
  Analyzing Your Custom Expense Report ................................150
  Programming the Mapping Table ..............................................151
  Using Applications Other Than Microsoft Excel ....................156
  Expense File Details ...................................................................156

Appendix C: Non-ASCII Characters for Login Scripts
  Use of ^char ...............................................................................157
  Carriage Return and Line Feed ...............................................157
  Literal Characters ......................................................................158

Index
  Index ..........................................................................................159
Chapter 1

Address Book

The Address Book enables you to keep names, addresses, phone numbers and other information about your personal or business contacts.

With the Address Book, you can:

- Quickly look up or enter names, addresses, phone numbers and other information.
- Enter up to five phone numbers (home, work, fax, car, etc.) or e-mail addresses for each name.
- Define which phone numbers appear in the Address List screen for each Address Book entry.
- Attach a note to each Address Book entry where you can enter additional information about the entry.
- Assign categories to your Address Book entries, so you can quickly sort and view your entries in logical groups.

To open the Address Book:

- Press the Address Book button on the front panel of the Palm III™ connected organizer to display the Address Book on the screen.
Getting Started With Address Book Entries
An Address Book entry is where you store name and address information about people or businesses. Your Palm III organizer makes it easy to create, edit and delete Address Book entries.

Creating an Address Book Entry
You can create Address Book entries on your Palm III organizer, or you can use the Palm ™ Desktop software to create Address Book entries on your computer and download the entries to your Palm III organizer with the next HotSync® operation. See the “HotSync” chapter for details.

Note: The Palm Desktop software also has data Import capabilities that enable you to load database files into the Address Book on your Palm III organizer. Refer to the online documentation supplied with the Palm Desktop software for details.

To create a new Address Book entry:
1. Press the button on the front of your Palm III organizer to display the Address List screen.
2. Tap the New button to display the Address Edit screen.
3. Enter the last name of the person you want to add to your Address Book.
Note: Your Palm III organizer automatically capitalizes the first letter of each field (except numeric and e-mail fields). You do not have to use the Graffiti® capital stroke to capitalize the first letter of the name.

4. Use the Next Field Graffiti stroke to move to the First Name field.

Note: You can also move to any field by tapping it directly.

5. Enter the person’s first name in the First Name field.

6. Repeat steps 4 and 5 to enter the other information that you want to include in this Address Book entry.

7. Tap the arrows to move to the next page of information.

8. After you finish entering information, tap the Done button to return to the Address List screen.

Tip: You can create an Address Book entry that always appears at the top of the list by beginning the Last name (or Company name) field with a blank space. For example, you might create an "If Found Call" entry that contains your name and phone number in case you lose your Palm III organizer.
Editing an Address Book Entry

After you create an Address Book entry, you can update it or enter additional information any time.

To edit an Address Book entry:
1. Tap the Address Book entry that you want to change to display the Address View screen for that entry.
2. Tap the Edit button (or anywhere on the screen) to display the Address Edit screen.
3. Tap any field (Address, City, etc.) and enter or change the information.
4. After you finish, tap the Done button to return to the Address List screen.

Deleting an Address Book Entry

There are two ways to delete an entry: use the Menu Commands (described in the “Record Menu” section of this chapter) or use the Address Entry Details dialog.

To delete an entry with the Address Entry Details dialog:
1. Tap the Address Book entry that you want to delete to display the Address View screen for that entry.
2. Tap the Edit button to display the Address Edit screen.
3. Tap the Details button to open the Event Details dialog.
4. Tap the Delete button to open the Delete Address alert.
5. Tap the OK button to confirm you want to delete the entry.
Working With Address Book Entries

Your Palm III organizer enables you to quickly find your Address Book entries, group them by category, and display the entries by name or company name. You can also choose the type of information you want your entries to include and exchange Address Book information with other 3Com® connected organizer users.

Looking Up Address Book Entries

When working with the Address Book, the scroll button on the front panel of the Palm III organizer makes it easy to navigate among your address entries. In the Address List screen, the scroll button moves up or down an entire screen of address entries. If you hold down the scroll button, you accelerate the scrolling so that it displays every third screen. In the Address View screen, the scroll button moves to the previous or next address entry.

You can also use the Address List Look Up feature to quickly scroll to any of your Address Book entries.

To Look Up an Address Book entry:
1. Display the Address List screen.
2. Enter the first letter of the name you want to find.

   Note: The letter appears on the Look Up line and the list scrolls to the first entry that begins with that letter. If you write another letter, the list scrolls to the first entry that starts with those two letters. For example, writing an “s” might scroll to “Sands,” and writing “sm” might scroll further to “Smith.” If you sort the list by company name, the Look Up feature scrolls to the first letter of the company name.

3. Tap any entry to view its contents, or use the carriage return stroke to view the selected entry.
Choosing Types of Phone Numbers
Your Palm III organizer enables you to choose the types of phone numbers or e-mail addresses that you associate with an Address Book entry. Any changes you make will apply only to the current Address Book entry.

To choose other types of phone numbers in an Address Book entry:
1. Tap the Address Book entry that you want to change to display the Address View screen for that entry.
2. Tap the Edit button to display the Address Edit screen for that entry.
3. Tap the pick list next to the label you want to change.
4. Tap the new label you want to use.

Assigning Address Categories
Categories can help you file individual Address Book entries into groups for easy review. You can assign and edit categories in the Address Book or by using the Categories pick list in the Details dialog (see “Using Categories” in the Basic Handbook for the Palm III Organizer for a complete description of categories).

To assign a category to an Address Book entry:
1. Tap the Address Book entry you want to assign to a category.
2. Tap the Edit button in the Address View screen to display the Address Edit screen.
3. Tap the pick list in the upper-right corner and tap the category that you want to assign to the Address Book entry.
Sorting by Name or Company
You can sort the entries in the Address List screen by Company and Last Name, rather than by Last Name and First Name. These settings do not change your Address Book data in any way; they merely change the view.

To sort the entries in the Address List screen:
1. Display the Address List screen.
2. Tap the icon to open the Address Book menus.
3. Tap Preferences from the Options menu to open the Address Book Preferences dialog.
4. Tap the setting that you want for the Address List screen.
5. Tap the OK button to display the Address List screen with your new setting.

Note: Entries with no company name sort by last name.

Changing Address Entry Details
The Address Entry Details dialog provides a variety of options that you can associate with an Address entry.

To open the Address Entry Details dialog:
1. Tap an Address Book entry to display the Address View screen for that entry.
2. Tap the Edit button to display the Address Edit screen.
3. Tap the Details button to open the Address Entry Details dialog.
4. Select any of the following settings:

**Show in List** Choose which type of phone or other information appears on the Address List screen for the current entry. Your options are: Work, Home, Fax, Other and E-mail.

**Category** Assign the entry to a particular category. Your options are: Business, Personal, QuickList, Unfiled and Edit Categories.

**Private** Hide this entry when the security features are turned on.

**Beaming Address Entries to Other 3Com Connected Organizers**

The IR port on your Palm III organizer enables you to beam Address Book entries to other 3Com connected organizers. You can beam any of the following:

- **Business card.** A specially designated entry containing information you want to exchange with business contacts. You can send your business card quickly with one-touch beaming.

- **Current address entry.** The entry currently selected on your Palm III organizer. For example, you may want to beam the name of a business contact to a coworker who also uses a Palm III organizer.

- **Category of address entries.** All of the entries that you have assigned to the selected category. For example, you might want to share your list of restaurants with a friend.

**Note:** For more on the IR port, see “Beaming Information to Other 3Com Connected Organizers” in the Basic Handbook for the Palm III Organizer.

**To select a business card:**

1. Create an Address Book entry containing the information you want on your business card.

2. Tap your business card entry to display the Address View screen for that entry.

3. Tap the ![icon] icon to open the Address Book menus.

4. Tap Select Business Card from the Record menu, and tap Yes to accept this entry as your business card.
To beam a business card:
1. Tap your business card entry to display the Address View screen for that entry.
2. Tap the icon to open the Address Book menus.
3. Tap Beam Business Card from the Record menu to beam your card to another 3Com connected organizer.

Tip: You can press the button for about two seconds to beam your card.

To beam the current entry:
1. Tap an Address Book entry that you want to beam to display the Address View screen for that entry.
2. Tap the icon to open the Address Book menus.
3. Tap Beam Address from the Record menu to beam the current entry to another 3Com connected organizer through the IR port.

Tip: You can set the full-screen pen stroke to beam the current entry. See “Pen Preferences” for details.

To beam the current category:
1. Display the Address List screen.
2. Tap the pick list in the upper-right corner and tap the category you want to beam to display the entries in that category.
3. Tap the icon to open the Address Book menus.
4. Tap Beam Category from the Record menu to beam the entries in the current category to another 3Com connected organizer through the IR port.
Address Book Menu Commands

The Address Book includes menu commands to make it fast and easy to perform common file and editing tasks. This section explains the menu commands that are specific to the Address Book.

Refer to “Using Menus” in the Basic Handbook for the Palm III Organizer for information about menu commands that are common to all of your Palm III organizer applications.

Record Menu

When you select the Record menu, its commands appear on the screen. The menu commands are slightly different depending on the current screen.

Delete Address

Opens an alert dialog prompting you to confirm deletion of the current entry. Tap the OK button to delete the entry from your Palm III organizer, or tap the Cancel button to close the alert dialog and keep the entry.

Note: By default, your Palm III organizer removes the entry from the Address Book, but retains a copy of the entry and transfers it to an archive file on your computer the next time you perform a HotSync operation. To remove the entry completely, clear the Save archive copy on PC check box.

Attach Note

Opens the Address Book Note dialog where you can create a Note for the current entry.
Options Menu

When you select the Options menu, its commands appear on screen.

**Delete Note**
Opens an alert dialog prompting you to confirm deletion of the Note attached to the entry. Tap the OK button to delete the Note, or tap the Cancel button to close the alert dialog and keep the note.

**Beam Address**
Beams the current Address Book entry to another 3Com connected organizer through the IR port.

**Beam Category**
Beams all Address Book entries in the current category to another 3Com connected organizer through the IR port.

**Select Business Card**
Enables you to select the current Address Book entry as your business card. To beam your business card to other 3Com connected organizers, use the Beam Business Card command.

**Beam Business Card**
Sends the current business card to another 3Com connected organizer through the IR port. You can also initiate this command by holding down the Address Book button for at least two seconds. This is a convenient way to exchange business cards with other 3Com connected organizer users.

**Font**
Opens the Select Font dialog where you can choose a different font (text) style for your Address Book entries. See “Choosing Fonts” in the *Basic Handbook for the Palm III Organizer* for details.
Preferences opens the Address Book Preferences dialog.

<table>
<thead>
<tr>
<th>Address Book Preferences</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remember last category</td>
</tr>
<tr>
<td>List By:</td>
</tr>
<tr>
<td>Last Name, First Name</td>
</tr>
<tr>
<td>Company, Last Name</td>
</tr>
<tr>
<td>OK Cancel</td>
</tr>
</tbody>
</table>

- **Remember last category.** Determines how the Address Book appears when you return from another Palm application (Memo Pad, To Do List, etc.). If you select this check box, the Address Book shows the last category you selected. When you clear it, the Address Book shows the address entries for all categories.

- **List By.** Determines whether address entries sort by last name, first name or by company name, last name in the Address List screen.

**Rename Custom Fields** enables you to define custom field names. Each Address Book entry contains four “custom fields” that you can rename. Any changes you make to the names of the custom fields appear in all of your Address Book entries.

<table>
<thead>
<tr>
<th>Rename Custom Fields</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create your own field names by editing the text on the lines below:</td>
</tr>
<tr>
<td>Custom 1:...</td>
</tr>
<tr>
<td>Custom 2:...</td>
</tr>
<tr>
<td>Custom 3:...</td>
</tr>
<tr>
<td>Custom 4:...</td>
</tr>
<tr>
<td>OK Cancel</td>
</tr>
</tbody>
</table>

**About Address Book** shows version (revision) information for the Address Book application.
Chapter 2

Calculator

The Calculator enables you to perform basic calculations. You can also store and retrieve values in the Calculator’s memory.

To opening the Calculator:

■ Tap the icon next to the Graffiti® area to open the Calculator screen.

Using the Calculator Screen
The Calculator is designed to perform addition, subtraction, multiplication and division operations.

To use the Calculator screen:

■ Use your fingers or the stylus to tap the Calculator buttons that appear on the screen.
**Special Calculator Buttons**

The Calculator includes several buttons to help you perform calculations.

- **CE** Clears the last number you entered. Use this button if you make a mistake while entering a number in the middle of a calculation. This button enables you to re-enter the number without starting the calculation over.

- **C** Clears the entire calculation and enables you to begin a fresh calculation.

- **+/−** Toggles the current number between a negative and positive value. If you want to enter a negative number, enter the number first and then press the +/− button.

- **M+** Places the current number into Memory. Each new number you enter with the M+ button is added to the total already stored in memory. The number that you add can be either a calculated value, or any number you enter by pressing the number buttons. Pressing this button has no effect on the current calculation (or series of calculations); it merely places the value into memory until it is recalled.

- **MR** Recalls the stored value from memory and inserts it in the current calculation.

- **MC** Removes any value that is stored in the Calculator memory.
Calculator Menu Commands

The Calculator supports the Copy and Paste commands. You can use these commands to copy a value from the Calculator and paste it into another application on your Palm III organizer. Similarly, you can copy values from other applications on your Palm III organizer, such as Expense, and paste the values into the Calculator. For additional information on the Copy and Paste commands, see “Using Menus” in the Basic Handbook for the Palm III Organizer.

Recent Calculations

The Recent Calculations command enables you to review the last series of calculations, and is particularly useful for confirming a series of “chain” calculations.

To display the Recent Calculations:

1. Tap the icon to open the Calculator menus.

2. Tap Recent Calculations from the Options menu to display the Recent Calculations screen.

3. After you finish reviewing the dialog, tap the OK button to close the Recent Calculations dialog and return to the Calculator.
Chapter 3

Date Book

The Date Book enables you to quickly and easily schedule appointments or any kind of activity associated with a time and date.

With the Date Book, you can:

- Enter a description of your appointment and assign it to a specific time and date.
- Display a chart of your appointments for an entire week. The Week View feature makes it easy to spot any potential scheduling overlaps or conflicts.
- Display a monthly calendar to quickly spot days where you have morning, lunch or afternoon appointments.
- Set an alarm to sound prior to the scheduled activity.
- Create reminders for events that are based on a particular date, rather than time of day. Birthdays and anniversaries are easy to track with your Palm III™ connected organizer.
- Attach notes to individual events for a description or clarification of the entry in your Date Book.

To open the Date Book:
Press the Date Book button on the front panel of the Palm III organizer to display the Date Book screen.
Scheduling an Event

An event can be any kind of activity that you associate with a day. When the Date Book screen first appears, it shows the current date and a list of times for a normal business day. You can enter a new event on any of the available time lines.

When you create an event, its description appears on the time line, and its duration is automatically set to one hour. You can easily change the start time and duration for any event.

You can also include events in your Date Book that occur on a particular date but have no specific start or end times, such as birthdays, holidays and anniversaries. These are referred to as untimed events. Untimed events appear at the top of the Date Book screen with a diamond in the time list. You can have several untimed events on a particular date.

To schedule an event for the current day:

1. Tap the time line that corresponds to your event in the Date Book screen.

2. Use the stylus to write Graffiti® character strokes (or the on-screen keyboard) to describe your event. You can enter up to 255 characters.

3. If your appointment is longer or shorter than an hour, tap the time of the event to open the Set Time dialog. If your appointment is one hour long, skip to step 7.
Note: You can also open the Set Time dialog (to select a start time) by making sure no event is selected, and then writing a number on the number side of the Graffiti writing area.

4. Tap the time columns on the right side of the Set Time dialog to set the Start Time.

5. Tap the End Time box, and then tap the time columns to set the End Time.

6. Tap the OK button to confirm your selection and close the Set Time dialog.

7. Tap a blank area of the screen to de-select the event. A vertical line appears next to the time, indicating the duration of the event.
To schedule an event for another day:
1. Select the date you want for the event by doing one of the following:
   - Tap the day of the week that you want in the Date Bar at the top of the Date Book screen. If necessary, tap the Previous week or Next week scroll bars to move to another week.
   - Tap the Go To button to open the Go to Date dialog. Select a date by tapping a year, month and day in the calendar.
   - Press the scroll button on the front panel of the Palm III organizer to scroll to another day. Press the upper half of the button to move to the previous day or the lower half to move to the next day.

2. After you locate the date, follow the steps described in the previous section, “To schedule an event for the current day.”
To schedule an untimed event:
1. Select the date that you want for the event as described in the previous section, “To schedule an event for another day.”

2. Tap New to open the Set Time dialog.

3. Tap OK, so that no start or end times are defined for the new event.

Note: You can also create a new untimed event by making sure no event is selected, and then writing letters in the Graffiti writing area.

4. Enter a description for the event (which appears at the top of the Date Book screen).

5. Tap a blank area on the screen to de-select the untimed event.

Note: If you create an event and decide later that there is no particular start or end time, you can easily change it to an untimed event. Tap the time of the event in the Date Book screen, tap the No Time button, and then tap the OK button to confirm your selection and close the Set Time dialog.
Rescheduling an Event

You can easily make changes to your schedule with your Palm III organizer.

To reschedule an event:
1. Tap the event you want to reschedule.
2. Tap the Details button to open the Event Details dialog for that event.
3. To change the time, tap the Time box and select the new time as described earlier in this chapter.
4. To change the date, tap the Date box and select the new date as described earlier in this chapter.
5. Tap the OK button to close the Event Details dialog and return to the Date Book screen.

Setting an Alarm for an Event

The Alarm setting enables you to set an audible alarm for events in your Date Book. You can set an alarm to sound minutes, hours or days before an event. The default Alarm setting is 5 minutes before the time of the event, but you can change this to any number of minutes, hours or days.

When you set an alarm, an icon appears to the far right of the event with the alarm. When the alarm tone sounds, a reminder message also appears on the Palm III organizer screen.

To set an alarm for an event:
1. Tap the event to which you want to assign an alarm.
2. Tap the Details button to open the Event Details dialog for that event.
3. Select the Alarm check box in the Event Details dialog to activate the alarm.
4. Tap the Alarm units pick list to select Minutes, Hours or Days.
5. Select the “5” and enter any number from 0 to 99 (inclusive) as the numeric alarm setting.
6. Tap the OK button to close the Event Details dialog and return to the Date Book screen.

**Note:** You can set a silent alarm for an untimed event. In this case, the alarm triggers at the specified period of minutes, hours or days before midnight (beginning) of the day of the untimed event. No audible alarm sounds for an untimed event; instead, the reminder message appears on the screen of the Palm III organizer.

For example, you could create a reminder for an untimed event that occurs on February 4th. If the alarm reminder is set for 5 minutes, the alarm reminder appears at 11:55 PM on the night of February 3rd. The reminder remains on the screen until you turn on your Palm III organizer and tap the OK button to dismiss it.

**Scheduling Repeating Events**

The Repeat function enables you to schedule events that recur at regular intervals. A birthday is a good example of an event that repeats annually. Another example would be a weekly guitar lesson that falls on the same day of the week and the same time of day. After you enter a repeating event, a icon appears to the far right of the event.
To schedule a repeating event:
1. Tap anywhere on the text of an event in the Date Book screen.
2. Tap the Details button to open the Event Details dialog.
3. Tap the Repeat box in the Event Details dialog to open the Change Repeat dialog.
4. Tap Day, Week, Month or Year in the Change Repeat dialog.
5. Enter a number that corresponds to how often you want the event to repeat in the “Every” area. For example, if you select Month and enter the number “2,” the event repeats every other month.
6. If you want to specify an ending date for the repeating event, tap the End on pick list and tap Choose Date. Use the Date Picker to select an end date.
7. Tap the OK button to close the Change Repeat dialog and activate your settings.

Considerations for the Repeat Function

- If you change the start date of a repeating event, your Palm III organizer calculates the number of days you have moved the event. Your Palm III organizer then automatically changes the end date to maintain the duration of the repeating event.
- If you change the repeat type (e.g., daily to weekly) of a repeating event, past occurrences (prior to the day on which you change the setting) are left alone and your Palm III organizer creates a new repeating event.
- If you change the date of an occurrence of a repeating event (e.g., from January 14th to January 15th) and apply the change to all occurrences, the new date becomes the start date of the repeating event. Your Palm III organizer adjusts the end date to maintain the duration of the event.
If you change other repeat settings (e.g., time, alarm, private) of a repeating event and apply the change to all occurrences, your Palm III organizer creates a new event. The start date of this new event is the day on which the setting is changed. Past occurrences (prior to the day of the change) are left alone and not changed.

If you make a change to one occurrence of a repeating event (e.g., time), that occurrence no longer shows the Repeat icon.

**Marking a Private Event**

You can designate a specific event as “private.” When you activate the Security features, your Palm III organizer hides all private entries and you must enter a password to display them on the screen.

**To mark an event as private:**
1. Tap the event you want to mark as private.
2. Tap the Details button to open the Event Details dialog for that event.
3. Select the Private check box.
4. Tap the OK button to close the Event Details dialog and return to the Date Book screen.

**Deleting an Event**

There are three ways to delete an event from the Date Book application: simply delete the text of the event, use the Menu Commands (described in the “Record Menu” section later in this chapter), or use the Event Details dialog.

**Note:** If you delete the text of a repeating event, you delete all instances of that event. If you use the Menu Command or the Event Details dialog, you can delete one occurrence of the event (as an exception) or all occurrences.

**To delete an event with the Event Details dialog:**
1. Tap anywhere in the text area of the event to delete.
2. Tap the Details button to open the Event Details dialog.
3. Tap the Delete button to open the Delete Event alert.
4. Tap the OK button to confirm you want to delete the event.
Changing the Date Book View

In addition to displaying the calendar for a specific day, you can also display your Date Book by the week or month, and you can display the current time.

To toggle through the different views:
■ Press the Date Book button repeatedly to display the next view.

To display the current time:
■ Tap the date in the Date Book title bar to display the current time.

Note: After a few seconds, the title bar reverts to show the date.

Working in Week View

The Week View shows a chart of your events for an entire week. This view lets you quickly review your appointments and available time slots.

In addition, the graphical display helps you spot overlaps and conflicts in your schedule.

To display the Week View:
1. Tap the Week View button in the Date Book screen to display the Week View.

2. Tap the navigation controls to move forward or backward a week at a time, or to display details of an event.

Note: The Week View also shows untimed events and events that are before and after the range of times shown.
3. Tap any of your events to show a description of the event.

If you want to reschedule an event, tap and drag the event to a different time or day.

You can tap a blank time on any day to move to that day and have the time selected for a new event. Or you can tap any of the days and dates that appear at the top of the Week View to move directly to that day without selecting an event.

The Week View shows the time span defined by the Start Time and End Time in the Date Book Preferences settings. If you have an event before or after this time span, a bar appears at the top or bottom of that day’s column, and these ⬇ on-screen scroll arrows appear if your scheduled events go beyond the displayed time range.
Spotting Event Conflicts in Week View

With the ability to define specific start and end times for any event, it’s possible to schedule events that overlap (an event that starts before a previous event finishes).

In this case, any event conflict (time overlap) appears in the Week View as overlapping bars. The Day View displays bracketed bars to the left of the conflicting times.

Working in Month View

The Month View screen shows which days have events scheduled. Dots and lines in the Month View indicate events, repeating events and untimed events.

Tap any day that appears in the Month View screen to move directly to that day with the Day View screen. Tap the arrows at the top to move forward or backward a month. Tap the Go to button to open the Date Picker and choose a different month.
When the Month View is on the screen, you can use the scroll button on the front panel of the Palm III organizer to move between months. Press the upper half of the button to display the previous month, or press the lower half to display the next month.

**Note:** You can control the dots and lines that appear in the Month View. See “Options Menu” later in this chapter.

### Date Book Menu Commands

The Date Book includes menu commands to perform common file and editing tasks. This section explains the menu commands that are specific to the Date Book.

See “Using Menus” in the *Basic Handbook for the Palm III Organizer* for information about menu commands common to all of your Palm III organizer applications.

#### Record Menu

When you select the Record menu, its commands appear on screen.

New Event

- Creates an event and opens the Set Time dialog where you can choose start and end times for the new event. If you do not enter start and end times, it creates a blank untimed event.

Delete Event

- Opens an alert dialog, prompting you to confirm that you want to delete the current event. You must tap an event before you use the Delete Event command. Tap the OK button to delete the event from your Palm III organizer, or tap the Cancel button to close the alert dialog and keep the event.
**Note:** By default your Palm III organizer removes the event from the Date Book, but retains a copy of the event and transfers it to an archive file on your computer the next time you perform a HotSync® operation. To remove the event completely, clear the Save archive copy on PC check box.

**Attach Note** Opens the Note dialog, where you can create a Note for the current event.

**Delete Note** Opens an alert dialog, prompting you to confirm that you really want to delete the Note attached to the event. Tap the OK button to delete the Note from the memory of your Palm III organizer, or tap the Cancel button to close the alert dialog and return to the Date Book.

**Purge** Opens an alert dialog, prompting you to confirm that you want to purge events older than a certain time period — based on the current date on the internal clock on the Palm III organizer. You can use the Purge command to conserve memory on your Palm III organizer. The default setting for the Purge alert is “Save archive copy on PC.” This setting removes events from the Date Book, but retains copies and transfers them to an archive file on your computer during the next HotSync operation.

**Note:** The Purge command also deletes repeating events if they end before the date that you activate the Purge command.

**Beam Event** Beams the current event to another 3Com® connected organizer through the IR port. See “Beaming Information to Other 3Com Connected Organizers” in the *Basic Handbook for the Palm III Organizer* for more information.
Options Menu

When you select the Options menu, its commands appear on screen.

<table>
<thead>
<tr>
<th>Record</th>
<th>Edit</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Font...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Preferences...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Display Options...</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Phone Lookup</td>
</tr>
<tr>
<td></td>
<td></td>
<td>About Date Book</td>
</tr>
</tbody>
</table>

**Font**

Opens the Select Font dialog where you can choose a different font (text) style for your Date Book entries. See “Choosing Fonts” in the Basic Handbook for the Palm III Organizer for details.

**Preferences**

Enables you to set the range of times that appear in the Date Book, and to automatically activate alarms for each event.

- **Start/End Time.** Enables you to define the start and end times for the Date Book screens. If the time slots you select do not fit on one screen, you can tap the arrows to scroll up and down.

- **Alarm Preset.** Automatically sets an alarm for each new event. The alarm for untimed events is defined by minutes, days or hours before midnight of the date associated with the event.

- **Alarm sound.** Controls the type of tone the alarm generates when it sounds.
- **Remind me.** Defines how many times the alarm sounds. The choices are: Once, Twice, 3 times, 5 times and 10 times.

- **Play every.** Defines how often the alarm sounds. The choices are every: Minute, 5 minutes, 10 minutes and 30 minutes.

**Display Options** Allows you to change the Date Book’s appearance and which events display.

- **Show Time Bars.** Activates the time bars that appear in the Day View. The time bars show the duration of an event and illustrate event conflicts.

- **Compress Day View.** Controls how times appear in the Day View. When Compress Day View is off, all time slots display. When it is on, start and end times display for each event, but blank time slots toward the bottom of the screen disappear to minimize scrolling.

- **Month View settings.** These check boxes apply to the Month View of the Date Book. You can activate any or all of these settings to show that you have Timed, Untimed or Daily Repeating events in the Month View only.

**Phone Lookup** Activates the Phone Lookup feature. See “Using Phone Lookup” in the Basic Handbook for the Palm III Organizer.

**About Date Book** Shows version (revision) information for the Date Book application.
Chapter 4
Expense

The Expense application enables you to keep track of your expenses and then transfer the information to a spreadsheet on your computer.

With the Expense application you can:

- Record dates, type of expenses, amount spent, payment method and other details associated with any money that you spend.
- Create categories for your expenses, such as business and personal expenses associated with a range of dates.
- Keep track of vendors (companies) and people involved with each particular expense.
- Log miles traveled for a particular date or expense category.
- Sort your expenses by date or expense type.
- Transfer your expense information to a Microsoft® Excel spreadsheet (version 5.0 or later) on your computer. (Microsoft Excel is not included with the Palm III™ connected organizer package.)

To open Expense:
1. Tap the icon to open the Applications Launcher.
2. Tap the icon to display the Expense List screen.

Creating an Expense Item
Expense enables you to record the date, expense type and the amount that you spent. You can sort your expense items into categories or add other information that you want to associate with the item.
To create an expense item:

1. Tap the New button in the Expense List to create a new item.

2. Enter the amount of the expense.

3. Tap the Expense Type pick list and select a type from the list.

Note: As soon as you select an expense type, your Palm III organizer saves your entry. If you do not select an expense type, it does not save the entry.

Tip: A quick way to create a new expense item is to make sure that no expense item is selected in the Expense List, write the first letter(s) of the expense type, and then write the numerical amount of the expense item. This technique takes advantage of the automatic fill feature. See “Options Menu” later in this chapter for details.
Changing the Expense Item Date

Initially, expense items appear with the date you enter them on your Palm III organizer. You can use the Expense application to change the date associated with any expense item.

To change the date of an expense item:
1. Tap the expense item you want to change to highlight the date.
2. Tap the date of the selected item to open the Date dialog.
3. Tap the date you want for the expense item.

For more information about the Date dialog, see “Scheduling an Event.”

Entering Receipt Details

The Expense application provides a variety of options that you can associate with an item. These options appear in the Receipt Details dialog.

To open the Receipt Details dialog:
1. Tap the expense item you want to assign details.
2. Tap the Details button to open the Receipt Details dialog.
3. Select any of the following options:

**Category**
Defines the category for the Expense item. The default Category is Unfiled when All is selected. Otherwise, the default is the currently selected Category. An expense item remains in the default category until you change it.

Your Palm III organizer provides two sample categories, New York and Paris, to show how you might sort your expenses according to different business trips.

Choose Edit Categories from the pick list to change existing or to create new expense categories. For example, you might create a category for a range of dates, such as a week or month, or you might delete or rename the New York and Paris categories.

**Type**
Opens a pick list of the expense type options so that you can change the expense type for any of your expense items.

**Payment**
Enables you to choose the payment method used to pay the expense item. If the item is prepaid (such as airline tickets supplied by your company), you can choose Prepaid to place your expense in the appropriate company-paid cell of your printed expense report spreadsheet. See “Transferring Your Data to Microsoft Excel” later in this chapter for more information.

**Currency**
Enables you to choose the type of currency used to pay the expense item. The default currency unit is defined in the Preferences dialog (see “Preferences Menu” later in this chapter). You can also display up to four other common types of currency. See “Customizing the Currency Pick List” later in this chapter for details.
Vendor and City

Enable you to record the name of the vendor (usually a company) associated with the expense and the city where the expense took place. For example, a business lunch might be at Rosie’s Cafe (Vendor) in San Francisco (City).

Attendees

Displays the Attendees screen which resembles a memo in the Memo Pad. You can use this screen to list the people who attended the activity associated with the expense or to make notes, such as the purpose of the expense.

Note:

You can tap the Lookup button to display the names (and the corresponding companies) of the people in your Address Book. The Lookup button’s function is similar to the Phone Lookup feature described in “Using Phone Lookup” in the Basic Handbook for the Palm III Organizer.

4. Tap the OK button to close the Receipt Details dialog and activate your selections.
Customizing the Currency Pick List
You can select the currencies and symbols that appear in the Currency pick list.

To customize the Currency pick list:
1. Tap the Currency pick list in the Receipt Details dialog, and then tap the Edit Currencies selection to open the Select Currencies dialog.
2. Tap each Currency pick list to choose the country whose currency you want to display on that line.
3. Tap the OK button to close the Select Currencies dialog and activate your selections.

Note: If the currency you want to use is not in the list of countries, you can create your own custom country and currency symbol. See “Expense Menu Commands” later in this chapter for details.

Show Options
The Show Options define the sort order and other settings that relate to your expense items.

To open the Show Options dialog:
1. Tap the Show button in the Expense List to open the Show Options dialog.
2. Select any of the following options:

**Sort By**
Enables you to sort the Expense entries by date or expense type.

**Distance**
Enables you to display Mileage entries in miles or kilometers.

**Show Currency**
Shows or hides the currency symbol in the expense list.

3. Tap the OK button to close the Show Options dialog and activate your selections.

**Transferring Your Data to Microsoft Excel**

After you enter your expenses into the Expense application on your Palm III organizer, the Palm™ Desktop software enables you to view and print the data with your computer.

**Note:** You need Microsoft Excel version 5.0 (or later) to view and print your Expense data using one of the provided templates. Microsoft Excel is not included with the Palm III organizer package. The procedures in this section also assume that you have installed the Palm Desktop software. See “Installing Palm Desktop Software” in the *Basic Handbook for the Palm III Organizer* for more information.
Printing an Expense Report
Palm Desktop makes it quick and easy to print your Expense data.

To print your expense report:
1. Perform a HotSync® operation to transfer your latest Expense data to your computer and make it available to Palm Desktop. See the “HotSync” chapter for details.
2. Click the Expense button in Palm Desktop to open Microsoft Excel and the Expense Report configuration dialog.
   Note: If you launch Expense from the Start menu (instead of Palm Desktop), you must first choose your Palm III organizer user name.
3. Click the expense category that you want to print.
   Tip: You can press Shift+click to select multiple categories. To print the expenses associated with all of your Expense categories, click the All button in the Categories area.
4. If you want to define an end date for the expense report, enter the date in the End Date area.
   Note: If you do not specify an end date, all expense entries for the selected categories will appear — up to the date of the last HotSync operation with your Palm III organizer.
5. Click the Print button to display the expense report in the Print Preview window.
6. Click the Print button in the Microsoft Excel window to print your expense report.

**To view your Expense data in a Microsoft Excel spreadsheet:**

1. Perform a HotSync operation to transfer your latest Expense data to your computer and make it available to Palm Desktop.

2. Click the Expense button in Palm Desktop to open Microsoft Excel and the Expense Report configuration dialog.

   **Note:** If you start Expense from the Start menu (instead of Palm Desktop), you must first choose your Palm III organizer user name.
3. Click the expense category that you want to use.

**Tip:** You can press Shift+click to select multiple categories. If you want to view the expenses associated with all of your Expense categories, click the All button in the Categories area.

4. If you want to define an end date for the expense report, enter the date in the End Date area.

**Note:** If you do not specify an end date, all expense entries for the selected categories will appear — up to the date of the last HotSync operation.

5. Click the Create button to display a Microsoft Excel spreadsheet containing your Expense data.
At this point, your Expense data appears in Microsoft Excel spreadsheet form. You can enter information, make formatting changes and save and print the file in the normal manner.

**Using Expense Report Templates**

Palm Desktop software comes with several expense report templates. When you use one of these templates, you can edit your Expense data in Microsoft Excel. If you want to streamline or customize your expense reports, you can change these templates. For example, you can add your company name to a template. See “Appendix A: Expense Templates” for sample templates and “Appendix B: Creating a Custom Expense Report” for details on changing templates.

**To view your Expense data using a Microsoft Excel template:**

1. Display your Expense data in a Microsoft Excel spreadsheet as described in the previous procedure.

2. Click the Options button to open the Expense Report Options dialog.

3. Enter name, department and other information as necessary for your expense report.

4. Click the Templates menu, then click an expense template. See “Appendix A: Expense Templates” for samples.

   **Note:** If you want to create your own custom expense template and have it appear in the Templates menu, refer to “Appendix B: Creating a Custom Expense Report.”

5. Click the OK button to return to the Expense Report Options dialog.
Expense Menu Commands

The Expense application includes menu commands to perform common file and editing tasks. This section explains the menu commands that are specific to the Expense application.

See “Using Menus” in the Basic Handbook for the Palm III Organizer for information about menu commands that are common to all of your Palm III organizer applications.

Record Menu

When you select the Record menu, its commands appear on screen.

Delete Item

Opens an alert dialog, prompting you to confirm that you want to delete the current expense item. You must tap an item before you can use the Delete Item command. Tap the OK button to delete the item from your Palm III organizer, or tap the Cancel button to close the alert dialog and keep the item.

Note: By default your Palm III organizer removes the item from the Expense application, but retains a copy of the item and transfers it to an archive file on your computer the next time you perform a HotSync operation. To remove the item completely, clear the Save archive copy on PC check box.

Purge

Conserves memory on your Palm III organizer by deleting expense categories that you no longer use.

The Purge command prompts you to confirm that you want to purge all the records from the selected category.
Options Menu
When you select the Options menu, its commands appear on screen.

Preferences
Activates the Preferences dialog, which is used to activate the automatic fill feature and to set the default currency symbol.

- **Use automatic fill.** Enables you to select an expense type by writing the first letter of an expense type in the Graffiti writing area. For example, if you write the letter “T,” it enters the “Taxi” expense type. Writing “T” and then “E” enters “Telephone” which is the first expense type beginning with the letters “TE.”

- **Default currency.** Sets the default currency symbol for the Expense application.

Custom Currencies
Enables you to define additional currency symbols for the Expense application.

**Note:** You need to use this command only if the currency symbol you need is not available in the Currency pick list of the Receipt Details dialog (See “Entering Receipt Details” earlier in this chapter).

About Expense
Shows version (revision) information for the Expense application.
To define a custom currency symbol:

1. Choose Custom Currencies from the Options menu to open the Custom Currencies dialog.

2. Tap one of the four Country boxes to open the Currency Properties dialog.

3. Enter the name of the country and the symbol that you want to appear in the Expense application, and then tap the OK button to define your setting.

4. Tap the OK button to close the Custom Currencies dialog.

Note: If you want to use your custom currency symbol as the default for all Expense entries, choose the symbol in the Preferences dialog. If you want to use your custom currency symbol only for particular expense items, choose the symbol in the Receipt Details dialog associated with those items.
Chapter 5

HotSync®

HotSync® technology enables you to synchronize data between one or more 3Com® connected organizers and the Palm™ Desktop software. To synchronize data, you must connect your Palm III™ connected organizer and Palm Desktop either directly with a cable or indirectly with a modem or network.

With HotSync technology you can:
- Synchronize the Date Book, Address Book, To Do List, Memo Pad and Expense entries on your Palm III organizer with the entries on your computer, and vice versa.
- Manage individual or multiple 3Com connected organizers with a centralized computer.
- Keep your data safe by automatically creating backup copies each time your synchronize.

The HotSync Process and the HotSync Manager

The HotSync process automatically synchronizes data between your Palm III organizer and Palm Desktop. Changes you make on your Palm III organizer or Palm Desktop appear in both places after a HotSync operation. HotSync technology synchronizes only the needed portions of files, thus reducing synchronization time. You can synchronize your data by connecting your Palm III organizer directly to your computer with the cradle or indirectly with a modem or network.

The HotSync Manager oversees the synchronization process. It runs in the background and monitors a communications port on your computer for a HotSync command from a 3Com connected organizer. When it “hears” a HotSync command, HotSync Manager synchronizes data in the Date Book, Address Book, To Do List, Memo Pad, Mail and Expense applications. It can synchronize the data even when Palm Desktop is not running!

Once you complete a few simple setup steps, performing a HotSync operation is as simple as pressing a button. Follow the steps in the next section to complete the setup.
Performing a HotSync Operation for the First Time

The first time you synchronize your data, you need to enter user information on both the Palm III organizer and the Palm Desktop. Once you enter this information and synchronize, the HotSync Manager recognizes your Palm III organizer and doesn’t ask for this information again. If you are a System Administrator preparing several 3Com connected organizers for a group of users, see “Creating a User Profile” later in this chapter before performing the following steps.

**Important:** You must perform your first HotSync operation with a local, direct connection, rather than using a modem.

To perform a HotSync operation for the first time:

1. Double-click the Palm Desktop icon on the Windows desktop (or select Palm Desktop from the Start menu) to start the Palm Desktop software.
2. Click the icon in the Windows System Tray to open the HotSync Manager menu.

**Tip:** The Windows System Tray is usually in the lower-right corner on your computer display. The location may vary depending on the location of the taskbar and the version of Windows you are using.

3. Click Local from the HotSync Manager menu to indicate that you are using the cradle to synchronize.
4. Turn on the Palm III organizer and slide it into the cradle.
Tip: The curved edge on the bottom of the Palm III organizer should align smoothly with the cradle when it is inserted properly.

5. Press the button on the front of the Palm III organizer cradle to open the New User dialog.

6. Enter a user name for your Palm III organizer and click the OK button to open the HotSync Progress dialog and start the synchronization process.

Important: Every 3Com connected organizer should have a unique name. Never try to synchronize more than one 3Com connected organizer to the same user name.
7. Wait for Palm Desktop to display a message indicating that the process is complete.

**Conducting a Local HotSync Operation**
After you complete the first HotSync operation, the HotSync process is even faster and easier!

**To conduct a local HotSync operation:**
1. Insert the Palm III organizer in the cradle.
2. If the HotSync Manager is not running, start it.
3. Press the button on the front of the Palm III organizer cradle to start the HotSync process.
4. Wait for Palm Desktop to display a message indicating that the process is complete.

**Selecting HotSync Setup Options**
You can choose when you want HotSync Manager to run, and you can adjust the local and modem HotSync settings.

**To set the HotSync Options:**
1. Click the icon in the Windows System Tray to open the HotSync Manager menu.
2. Click Setup on the HotSync Manager menu to open the Setup dialog.
3. Click the General tab and select one of the following options:

**Always available**
Adds HotSync Manager to the Startup folder and constantly monitors the communication port for 3Com connected organizer synchronization requests. With this option, the HotSync Manager conducts synchronizations even when Palm Desktop is not running.

**Available only when Palm Desktop is running**
Starts HotSync Manager and monitors requests automatically when you open the Palm Desktop software.

**Manual**
Starts the HotSync Manager and monitors requests only when you select HotSync Manager from the Start menu.

*Tip:* If you’re not sure which option to use, keep the Always available default setting.

4. Click the Local tab to display the settings for the connection between your computer and the Palm III organizer cradle, and adjust the following options as needed.
5. Click the Modem tab to display the Modem settings and adjust the following options as needed.

**Serial Port**
Identifies the port Palm Desktop will use to communicate with the cradle. This selection should match the port number where you connected the cradle.

**Note:** Your Palm III organizer cannot share this port with an internal modem or other device. If you have trouble determining the correct serial port, see “Troubleshooting” in the *Basic Handbook for the Palm III Organizer.*

**Speed**
Determines the speed at which data is transferred between your Palm III organizer and Palm Desktop. We suggest you try the As Fast As Possible rate first, and adjust downward if you experience problems. This setting allows the Palm Desktop and Palm III organizer to find and use the fastest speed.
Serial Port  Identifies the port where the modem is located. If you are unsure of the port assignment, look at the Modem Properties in the Windows Control Panel.

Speed  Determines the speed at which data is transferred. We suggest you try the As Fast As Possible rate first, and adjust downward if you experience problems. This setting allows the Palm Desktop and Palm III organizer to find and use the fastest speed.

Modem  Identifies the modem type or manufacturer. Refer to your modem manual or face plate for its type or settings. If you’re not sure of your modem type or your modem doesn’t match any that appear in the list, choose Hayes Basic.

Setup String  Identifies the setup string for your particular modem. Not all modems require a setup string. Refer to your modem manual and enter the setup string if recommended by the manufacturer.

6. Click OK to close the Setup dialog.
Customizing HotSync Application Settings

For each application you can define a set of options that determines how records are handled during synchronization. These options are called a “conduit.” By default, Palm Desktop synchronizes all files between the Palm III organizer and the Palm Desktop. In general, you should leave the settings to synchronize all files. The only reason you might want to change these settings is to overwrite data on either your Palm III organizer or Palm Desktop, or to avoid synchronizing a particular type of file because you don’t use it.

In addition to the Date Book, Address Book, To Do List, Memo Pad and Expense application conduits, Palm Desktop includes System and Install conduits. The System conduit backs up the system information stored in your Palm III organizer, including Graffiti® software ShortCuts. The Install conduit is used to install Palm-compatible applications.

To customize HotSync application settings:

1. Click the icon in the Windows System Tray to open the HotSync Manager menu.
   
   Tip: You can also click the HotSync command on the Palm Desktop menu bar to open the HotSync Manager menu.

2. Click Custom from the HotSync menu to open the Custom dialog.

3. Select the appropriate user name from the list at the top of the dialog.

4. Click an application in the Conduit list to choose the conduit you want to change.

5. Click the Change button to open the Change HotSync Action dialog.
6. Click the direction in which you want to write data, or click Do Nothing to skip data transfer for an application.

**Note:** Changing the HotSync setting from the default affects only the next HotSync operation. Thereafter, the HotSync Actions revert to their default settings. To use a new setting on an ongoing basis, select the Set As Default box. Thereafter, you can just click the Default button in the Custom dialog to revert to the default settings.

7. Repeat steps 2 through 5 to change conduit settings for other applications or for a different user name.

8. Click the OK button to close the Change HotSync Action dialog and activate your settings.

**Conducting a HotSync Operation via Modem**

You can use a modem to synchronize your Palm III organizer when you are away from your computer.

**Note:** You must conduct an initial local HotSync operation using the Palm III organizer cradle before you perform a modem HotSync operation.

To perform a HotSync operation via modem you need:

- A modem connected to your computer
- A modem connected to your Palm III organizer with a special modem cable. (The cradle is not used for a modem HotSync operation.) See “Technical Support, Service and Repair” in the *Basic Handbook for the Palm III Organizer* for details on ordering this special cable.
- The Palm Desktop software configured for use with a modem as described earlier in this chapter in “Selecting HotSync Options.”
Preparing Your Computer for a Modem HotSync Operation

There are a few steps you must perform to prepare your computer for a modem HotSync operation. Be sure to perform these steps before you leave your office so that your computer is ready to receive a call from your Palm III organizer. See “Selecting HotSync Setup Options” earlier in this chapter.

To prepare your computer for a modem HotSync operation:

1. Confirm that the computer modem is connected and turned on, and that no communications applications, such as fax or telephony software, are running on a COM port.

   Note: Make sure the computer is disconnected from all online services, such as America Online® (AOL) and CompuServe®. This helps to avoid conflicts with the COM port.

2. Start HotSync Manager if it is not already running, and click Modem from the HotSync Manager menu.

Preparing Your Palm III Organizer for a Modem HotSync Operation

There are a few steps you must perform to prepare your Palm III organizer for a modem HotSync.

To prepare your Palm III organizer for a modem HotSync operation:

1. Turn on your Palm III organizer and tap the icon to open the Applications Launcher.

2. Tap the icon to open the HotSync screen.

3. Tap the Enter Phone # box under the Modem Sync icon to open the Phone Setup dialog.

Phone Setup

Phone #: ..............................................
..............................................

☐ Dial prefix: ..............................................

☐ Disable call waiting: 1170

☐ Use calling card:

..............................................

OK  Cancel
Note: If you have Network HotSync software installed on your Palm III organizer, the Remote Setup dialog appears instead. See “Network Preferences” for more information.

4. Enter the telephone number to access the modem connected to your computer.

5. If needed, enter a dial prefix (such as “9”) to access an outside line, and then tap the Dial Prefix check box.

Tip: You can enter a comma in the field to introduce a “pause” in the dialing sequence.

6. If the phone line you’re using for the Palm III organizer has “Call Waiting,” select the Disable call waiting check box to avoid an interruption during the modem HotSync operation.

7. If you want to use a calling card to place the call, select the check box and enter the calling card number.

8. Tap OK to return to the HotSync dialog.

9. Tap the icon to open the HotSync menus.

10. Tap Modem Setup from the Options menu to display the Modem Preferences screen.

11. Enter the Modem Preference settings as described in “Modem Preferences.”

Selecting the Conduits for a Modem HotSync Operation

The Conduit Setup dialog on your Palm III organizer enables you to define which files and/or applications synchronize during a modem HotSync operation. You can use these settings to minimize the time required to synchronize data with a modem.

To change the Conduit Setup for a modem HotSync operation:

1. Tap the icon in the Graffiti area to display the Applications Launcher.

2. Tap the icon to display the HotSync screen.

3. Tap the icon to open the HotSync menus.

4. Tap Conduit Setup from the Options menu to open the Conduit Setup dialog.
5. Tap the check boxes to de-select the files and/or applications that you do not want to synchronize during a modem HotSync operation. The default setting is to synchronize all files.

Note: Applications that do not have a database (such as games) do not synchronize — even if you select the item in the Conduit Setup dialog.

6. Tap the OK button to close the Conduit Setup dialog and activate your settings for the next modem HotSync operation.

Performing a HotSync Operation via a Modem:

After you prepare your computer and your Palm III organizer, and select your Conduit Setup options, you are ready to perform a Modem HotSync operation.

To perform a Modem HotSync operation:

1. Turn on your Palm III organizer.

Note: If you are not using a PalmPilot modem, you need a special modem cable and an external modem. Connect one end of the special modem cable to the serial connector on the Palm III organizer and the other end to the external modem. Do not attempt to use other kinds of cables, even if they appear to be similar.

2. Tap the icon to open the Applications Launcher.

3. Tap the icon to open the HotSync application.

4. Tap the icon to dial the Palm Desktop modem and synchronize the applications selected under Conduit Setup.

5. Wait for the HotSync operation to complete. If you have any problems conducting a successful HotSync operation, see “Troubleshooting” in the Basic Handbook for the Palm III Organizer.
Conducting HotSync Operation via a Network

When you use the Network HotSync software, you can take advantage of the LAN and WAN connectivity available in many office environments. The Network HotSync software enables you to perform a HotSync operation using a cradle that is connected to any PC on your LAN or WAN (provided that the PC connected to the cradle also has the Network HotSync software installed and your PC is on and the HotSync Manager is running).

The Network HotSync software is an optional component that you can download from the Palm website (http://www.palm.com). The files that you download also include a setup program and documentation for this feature.

Creating a User Profile

If you need to configure a number of 3Com connected organizers with specific information (such as a company phone list) before distributing them to their actual users, you can create a User Profile to load the data into a 3Com connected organizer without associating that data with a user name. The User Profile feature is designed only for the first-time HotSync operation, before you assign a User ID to a particular 3Com connected organizer. See “Using File Link” later in this chapter for information about loading data after you assign a User ID.

To create a User Profile:

1. Open the Palm Desktop software.
2. Click Users from the Tools menu to open the Users dialog.
3. Click the Profiles button to open the Profiles dialog.
4. Click the New button to open the New Profile dialog.
5. Enter a name for the Profile and click the OK button to return to the Profiles dialog.

6. Repeat steps 3 and 4 for each Profile that you want to create, then click the OK button to close the Profiles dialog and return to Palm Desktop.

7. Select the Profile from the User list and create the data for the Profile (e.g., company phone list, etc.).

**To use a Profile for the first-time HotSync operation:**

1. Place the new 3Com connected organizer in the cradle, and press the button on the cradle to open the Users dialog.

2. Click the Profiles button to open the Profiles dialog.

3. Choose the Profile that you want to load on the 3Com connected organizer, and click the OK button to open the following alert dialog:

4. Click the Yes button to transfer all the Profile data to the 3Com connected organizer.

The next time you perform a HotSync operation, Palm Desktop will prompt you to assign a User name to the 3Com connected organizer.


**Using File Link**

The File Link feature enables you to synchronize the Address Book and Memo Pad information on your Palm III organizer with a separate external file such as a company phone list. HotSync Manager stores the data in a separate category on your Palm Desktop and your Palm III organizer. You can configure the File Link feature to check for changes to the external file when you perform a HotSync operation.

With File Link you can synchronize with data stored in any of the following formats:

- Comma-separated (*.csv)
- Memo Pad archive (*.mpa)
- Address Book archive (*.aba)
- Text (*.txt)

For information on how to set up a File Link, see the Palm Desktop Software online Help.
Chapter 6

Mail

The Mail application enables you to manage your e-mail while away from your desk. The key to Mail is that it truly synchronizes the mail in your desktop e-mail application with the mail on your Palm III™ connected organizer.

For example, if you delete messages from your Palm™ Mail, your next HotSync® operation also deletes the messages from your desktop e-mail application — so you never have to delete messages twice. Similarly, if you read a message on your Palm III organizer and leave it in your inbox, your next HotSync operation marks it as read on your desktop e-mail.

With Mail, you can:

■ Use your Palm III organizer to send and/or retrieve e-mail messages from your desktop e-mail application.
■ View, delete, file and/or reply to incoming mail.
■ Create outgoing messages as well as drafts of messages that you can complete later.
■ Create simple or complex filters, which allow you to decide the type of e-mail that your Palm III organizer retrieves from your desktop e-mail application.

Setting Up Mail on the Desktop

Before you use Mail for the first time, your desktop e-mail application should be up and running. You must also set up the Palm™ Desktop software for use with your desktop e-mail application.

Note: The following instructions assume that you have already installed Palm Desktop software on your computer and that you did not set up Mail during the installation. If you have not yet installed the Palm Desktop software, the installation procedure will prompt you to set up Mail as part of the Palm Desktop software installation.
To set up Mail:
1. Click Start on the Windows desktop to open the Start menu.
2. Point to Programs, point to Palm Desktop, and then click Palm Mail Setup to start the setup procedure.
3. Follow the instructions on the screen to set up your Palm III organizer for use with your desktop e-mail application.

To select HotSync options:
1. Click the icon in the Windows System Tray to open the HotSync menu.
2. Click Custom from the HotSync menu to open the Custom dialog.
   
   Tip: You can also click Custom from the HotSync menu in Palm Desktop.
3. Click Mail in the Custom list box.
4. Click the Change button to open the Change HotSync Action dialog.

![Change HotSync Action](image-url)
5. Click one of the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Synchronize the files</strong></td>
<td>Synchronizes the mail on your Palm III organizer and your desktop e-mail application.</td>
</tr>
<tr>
<td><strong>Desktop overwrites handheld</strong></td>
<td>Replaces the mail on your Palm III organizer with the mail in your desktop e-mail application. You should use this option only if, for some reason, the two inboxes get out of sync. This setting applies for only one HotSync operation and then reverts back to the default setting.</td>
</tr>
<tr>
<td><strong>Do Nothing</strong></td>
<td>Turns off communication between your Palm III organizer and desktop e-mail application. This setting applies for only one HotSync operation and then reverts back to the default setting.</td>
</tr>
<tr>
<td><strong>Set As Default</strong></td>
<td>Changes the default setting on an ongoing basis. (When you first set up Mail, Synchronize the files is the default setting.)</td>
</tr>
</tbody>
</table>

**Tip:** To turn off mail, select Do Nothing and then select the Set as Default check box.

**To change your Mail setup options:**

1. Click the icon in the Windows System Tray to open the HotSync menu.
2. Click Custom from the HotSync menu to open the Custom dialog.
   **Tip:** You can also click Custom from the HotSync menu in Palm Desktop.
3. Click the Mail in the Conduit list to indicate that you want to change these settings.
4. Click the Change button to open the Change HotSync Action dialog for the Mail conduit.
5. Modify your settings as needed.
6. Click the OK button to confirm your changes and close the Change HotSync Action dialog.
Synchronizing Mail with your E-Mail Application

After you have enabled and configured Mail, you need to perform a HotSync operation to synchronize Mail with your desktop e-mail application. For a complete explanation of how to use the HotSync feature, see the “HotSync” chapter.

Opening Mail on your Palm III organizer

1. Tap the icon to open the Applications Launcher.
2. Tap the icon to display the Message List screen.

Viewing Messages

The Message List lists your incoming messages, who sent them and the date they were received. Messages you’ve read appear with a check next them and high-priority messages appear in bold.

To open a message:
- Tap a message in the list to open it.
Messages appear by default in the abbreviated mode. To switch from the abbreviated mode to the full header mode, see “Displaying Full Header Information” later in this chapter.

To close a message:
■ Tap the Done button to close the message and return to the Message List.

Message Fonts
You can modify the way messages appear by changing the font (text) style. See “Choosing Fonts” in the Basic Handbook for the Palm III Organizer for details.

Displaying Full Header Information
By default, Mail displays abbreviated header information. The abbreviated header displays only the From and Subject fields. The full header provides complete information about the sender, receiver and CC recipients, in addition to the subject and date the message was created. Mail uses the header type you select for all your messages.

To display full header information:
1. Open a message.
2. Tap the Complete Header icon to display the full header.

Complete Header icon
Abbreviated Header icon

Note: To redisplay the abbreviated header, tap the Abbreviated Header icon.
Creating Messages

You create messages with your Palm III organizer the same way you create messages with your desktop e-mail application: you identify the recipient(s) of the message, define a subject and create the body of the message.

You create original messages and replies in the New Message screen. All messages must, at the very least, contain information in the To and Subject fields.

To create a message:
1. Tap the New button in the Message List screen to display the New Message screen.

   ![New Message Screen](image)

   **Note:** You can also display the New Message screen by tapping New from the Message menu.

2. Use the stylus to write Graffiti® character strokes (or the on-screen keyboard) to enter the e-mail address of the recipient. The cursor indicates where new text will appear.
Note: Enter the address as if you are entering it from your
desktop e-mail application. For example, network users
sending a message to a user on the same network do not
need to add Internet information, such as @3com.com.

3. To send a carbon copy of this message to additional recipients, tap
in the CC field, then enter the e-mail addresses of the additional
recipients, separating the addresses with a comma followed by a
space.

4. Tap in the Subj field, then enter a subject for your message.

5. Tap in the Body field, then enter the body text.

Note: If the address, CC, subject or body of the message exceeds
the capacity of the screen display, tap the name of the
field (for example, “To”) to expand that field. Tap the
Done button to return to the New Message screen.

To reply to a message:

1. Tap a message in the Message List to display it on the screen.

2. Tap the Reply button to open the Reply Options dialog.
3. Select who you want to receive the reply: only the Sender, All recipients and the sender or do you want to Forward the message to someone else.

4. Select whether you want to Include original text and Comment original text.

5. Tap OK to close the Reply Options dialog and display the New Message screen.

6. Enter your reply text.

   **Note:** You have several message options including setting the priority. See “Adding Message Details” for details.

7. Tap Send to place your reply in the Outbox.

**Looking Up an Address**

To identify the recipient of a message, you need to enter that person’s e-mail address in the appropriate field of the Message screen. You can do this either by entering the data directly into the field or by using the Look Up command to access the information in your Address Book.

**To look up an address:**

1. Tap either the To or CC field name to expand one of these fields.

2. Enter a few letters of the address you want to find.

3. Tap the Lookup button.

4. If the letters you enter identify a unique listing from your Address Book, your Palm III organizer completes the address for you. If not, the Lookup dialog appears.

   **Note:** You can also open the Look Up dialog in the New Message screen by tapping Lookup from the Options menu or by using the Command stroke /L.
5. Enter the first letter of the entry you want to find to scroll to the first entry that begins with that letter. If you write an additional letter, the list scrolls to the first entry that starts with those two letters. For example, writing an “s” might scroll to “Sanders,” and writing “sm” might scroll farther to “Smith.”

6. Tap an address to select it.

7. Tap the Add button to enter the address in the To or CC field.
Adding Message Details

Before you send your message, you can attach additional attributes (called message details) to your message, such as a signature block, or flagging the message as high-priority. These features are dependent on the desktop e-mail application you use. If your e-mail application does not support the message detail you select, your Palm III organizer cannot attach that attribute to your message.

The following message details are available:

**Priority** Flags a message as high, normal or low priority.

**BCC** Creates a blind carbon copy field in the New Message screen.

**Signature** Attaches previously defined text as a signature block. See “Adding a Signature to Your Message” later in this chapter for details.

**Confirm Read** Requests a confirmation telling you when the message was read.

**Confirm Delivery** Requests a confirmation telling you when the message was delivered.

**Note:** The Priority and BCC settings are valid only for the current message and must be set with each subsequent message you create.

Setting a Priority

**To set a priority for your message:**

1. Tap the Details button in the New Message screen to open the Message Details dialog.

![Message Details Dialog](image)
2. Tap the Priority pick list and select the priority you want.

![Message Details](image)

3. Tap the OK button to confirm your selection and return to the New Message screen.

**Note:** Your Palm III organizer can flag messages with a specific priority only if your desktop e-mail application supports this feature.

**Sending a Blind Carbon Copy**

**To add a BCC field to your message:**
1. Select the BCC check box in the Message Details dialog to add the BCC field to the New Message screen.
2. Tap the OK button to confirm your selection and return to the New Message screen.

![New Message](image)

3. Tap the BCC field and enter the address.

Adding a Signature to Your Message

Adding a signature to your message is a two-part process: first, you must create your signature, then you must select the signature option from the Message Detail dialog.

To create a signature:
1. Tap the icon to open the Mail menus.
2. Tap Preferences from the Options menu to open the Preferences dialog.

```
Preferences

Confirm deleted message
Signature text:
..........................................................
..........................................................
..........................................................
..........................................................
..........................................................
..........................................................
OK  (cancel)
```

3. Tap in the Signature Text field and enter up to six lines of text.
4. Tap the OK button to confirm your selection and return to the previous screen.

To add a signature to your message:
1. Tap the Details button in the New Message screen to open the Message Details dialog.
2. Select the Signature check box to add a signature to the end of your message.
3. Tap the OK button to confirm your selection and return to the New Message screen.

Note: The signature block does not display in your message; only your recipient sees the signature block.
Requesting Confirmations

To receive a confirmation when your message is read:
1. Tap the Details button in the New Message screen to open the Message Details dialog.
2. Select the Confirm Read check box to request a confirmation when the recipient reads your message.
3. Tap the OK button to confirm your selection and return to the New Message screen.

To receive a confirmation when your message is delivered:
1. Tap the Details button in the New Message screen to open the Message Details dialog.
2. Select the Confirm Delivery check box to request a confirmation that the recipient received your message.
3. Tap the OK button to confirm your selection and return to the New Message screen.

Sending Messages

When you send messages from your Palm III organizer, it stores them in the Outbox folder until the next time you synchronize your Palm III organizer with your computer. During synchronization, all messages stored in the Outbox folder are transferred to the Outbox folder in your desktop e-mail application. Messages created on your Palm III organizer are transmitted the next time you send mail from your desktop e-mail application.

To send a message:
- After you create a message, tap the Send button in the New Message screen.
Editing an Unsent Message

You can edit or make changes to a message that has not yet been sent, as long as you have not yet performed a HotSync operation. When you edit a message, your Palm III organizer removes the message from the Outbox folder and takes you back to the New Message screen, where you can edit the message and resend it, save it as a draft or cancel it.

To retrieve a message:

1. In the Message List screen, tap Outbox from the pick list in the upper-right corner to display the messages contained in the Outbox.

2. Tap the message you want to retrieve to display the message.

3. Tap the Edit button to remove the message from the Outbox folder and place it back in the New Message screen.
Draft Messages

There are times when you may not want to immediately send a message you compose — for example, you may want to add additional information before sending it. Your Palm III organizer stores such messages in the Draft folder until you are ready to edit them. When you edit a draft, it becomes a new message again.

**Note:** When you’re creating or editing a message, you can also save a message as a draft by canceling it. When you cancel a message, Palm III organizer opens a dialog asking if you want to save the message. If you tap the Yes button, your Palm III organizer saves a draft of your message.

**To save a message as a draft:**
1. Create a message in the New Message screen.
2. Tap the icon to open the Mail menus.
3. Tap Save Draft from the Message menu to move the message to the Draft folder.

**To edit a message saved as a draft:**
1. In the Message List screen, tap Draft from the pick list in the upper-right corner to display a list of the messages in the Draft folder.
2. Tap the draft you want to display.
3. Tap the Edit button to move your draft to the New Message screen.
4. Enter your changes, then either save it again as a draft or tap the Send button to move the message to your Outbox folder.
Filing a Message
Your Palm III organizer can store any message you receive or create in the Filed folder. The contents of this folder do not automatically synchronize with your desktop e-mail application during a HotSync operation. However, your Palm III organizer does store a back-up copy of the Filed folder on your computer hard drive.

To file a message:
1. Open a message.
2. Tap the icon to open the Mail menus.
3. Tap File from the Message menu to display the Message File Options dialog.
4. Tap No to save the message and move it to the Filed folder or tap Yes to file the message and keep a copy in the Inbox.

To remove a message you created from the Filed folder:
1. In the Message List screen, tap Filed from the pick list in the upper-right corner to display the contents of the Filed folder.
2. Tap the message you want to restore.
3. Tap the Edit button to display and modify the message.

Note: After you display and modify the message, you can send it, save it as a draft, or return it to the Filed folder.

Deleting Messages
Your Palm III organizer stores deleted message in the Deleted folder until you perform the next HotSync operation. If you delete a message from Palm III organizer, it will be deleted on your desktop e-mail application after you perform a HotSync operation.

To delete a message:
1. Open the message you want to delete.
2. Tap the Delete button.
3. If you selected the Preference option to confirm message deletion, tap the Yes button to confirm that you want to delete the current message.
Removing a Message From the Deleted Folder
You can reverse the deletion of a message (by removing it from the Deleted folder) as long as you have neither performed a HotSync operation nor purged the contents of the Deleted folder.

To remove a message you received from the Deleted folder:
1. In the Message List screen, tap Deleted from the pick list in the upper-right corner to display the contents of the Deleted folder.
2. Tap the message you want to restore.
3. Tap the Undelete button to move the selected message to the Inbox and mark it as read.

To remove a message you created from the Deleted folder:
1. In the Message List screen, tap Deleted from the pick list in the upper-right corner to display the contents of the Deleted folder.
2. Tap the message you want to restore.
3. Tap the Edit button to display and modify the message.

Note: After you display and modify the message, you can send it or save it as a draft.

Purging Deleted Messages
Because your Palm III organizer stores deleted messages in the Deleted folder until you perform a HotSync operation, deleted messages can monopolize storage space. To avoid or correct this problem, you can purge the contents of your Deleted folder. Messages that you purge will still delete from your desktop e-mail application during the next HotSync operation.

To purge the contents of the Deleted folder:
1. Tap the icon to open the Mail menus.
2. Tap Purge Deleted from the Message menu.
3. When your Palm III organizer displays the Purge Deleted Messages alert, tap the Yes button to confirm that you want to purge the contents of the Deleted folder.

Note: You cannot restore messages after you purge them.
Message List Options
Message List Options enable you to manage the way the Message List displays information.

Folders
Your Palm III organizer provides five different folders, each pertaining to a particular mail category. The Message List displays the messages in the folder you select. Folders provide an efficient way to manage the mail you send and receive.

To select a folder:
1. Tap the pick list in the upper-right corner to open the following list of folders:

   - **Inbox**: Contains the mail from your desktop e-mail application Inbox, minus any that you have excluded using filtering options. See “Creating Special Filters” later in this chapter for details.
   - **Outbox**: Contains the mail you created and sent on the Palm III organizer since the last HotSync operation.
   - **Deleted**: Contains the messages you deleted since the last HotSync operation.
   - **Filed**: Contains the messages you want to store on the Palm III organizer.
   - **Draft**: Contains the messages you created using the Palm III organizer but are not yet ready to send.

2. Tap to select the folder you want to display in the Message List screen.

Date Column
The Date Column is optional in the Message List. By default, the Date Column is hidden to increase the available screen space.

To show the Date Column:
1. Tap the Show button in the Message List to open the Show Options dialog.
2. Select the Show Date check box to show the Date Column.

3. Tap OK to close the Show Options dialog and return to the Message List.

**Sorting the Message List**

You can sort the Message List by the date it was sent, by the sender or by the subject.

**Note:** High-priority messages always appear first, no matter how you sort your message list.

**To sort the Message List:**

1. Tap the Show button in the Message List to open the Show Options dialog.

2. Tap the Sort by pick list and select one of the following options:

   **Date**
   
   Sorts messages by date and displays the most recent message at the top of the screen.

   **Sender**
   
   Sorts messages by the sender’s user name and displays them in ascending alphabetical order — based on the first word of the sender field.

   **Subject**
   
   Sorts messages by the subject and displays them in ascending alphabetical order — based on the first word of the subject field.

3. Tap OK to close the Show Options dialog and return to the Message List.
**HotSync Options**

HotSync Options enable you to manage your e-mail more effectively by selecting which messages download when you synchronize your computer and your Palm III organizer. You can define different settings for local and remote synchronization. For example, you may want to download all of your messages during local synchronization and only urgent messages during remote synchronization. Once defined, your Palm III organizer determines if synchronization is occurring locally or remotely and uses the appropriate HotSync Options settings.

**To activate the HotSync Options dialog:**

1. Tap the icon to open the Mail menus.
2. Tap HotSync Options from the Options menu to open the HotSync Options dialog.
3. Tap the Settings for pick list and select Local HotSync or Remote HotSync.

**Note:** For more information about Local and Remote HotSync operations, see the “HotSync” chapter.

4. Tap the filtering option you want to apply. The following filtering options are available:
All
During synchronization, all of the messages in your desktop e-mail Inbox synchronize with your Palm III organizer and all messages in your Palm III organizer Outbox are sent to your desktop e-mail application.

Send Only
During synchronization, only the messages in your Palm III organizer Outbox are sent to your desktop e-mail application where they are sent to their final destination.

Filter
During synchronization, all messages in your Palm III organizer Outbox are sent to your desktop e-mail application, and messages in your desktop e-mail Inbox that meet specific criteria download to your Palm III organizer. When you select the Filter setting, the HotSync Options dialog opens and displays additional filter settings. See “Creating Special Filters” for details.

Unread
During synchronization, only unread messages download to your Palm III organizer from your desktop e-mail Inbox, and all messages in your Palm Outbox are sent to your desktop e-mail application.

Note: The All setting does not mean that all information included in each message downloads to your Palm III organizer. Truncation settings (explained in a following section) for long messages still apply. Also, Mail never downloads any attachments to your Palm III organizer. The message and any text information appear, but the attachment is left in your desktop e-mail application.

5. If you selected All, Send Only or Unread, tap the OK button to confirm your selection and close the HotSync Options dialog. If you selected Filter, continue to the next section.
Creating Special Filters

You can create special filters to control the type of messages that download to your Palm III organizer during synchronization. Special filters work on the premise of ignoring or retrieving messages that contain specific information in their header fields.

To create a special filter, you must decide whether you want to ignore or retrieve certain messages. Then, based on that decision, you must tell your Palm III organizer what it needs to look for in the To, From, and Subject header fields to single out those messages.

To access the special filter settings:

- Tap the Filter box in the HotSync Options dialog to display the filter settings.

Ignoring or Receiving Messages

The first step in establishing a special filter is to determine whether you want to ignore or retrieve messages that match the information you specify.

To define whether to ignore or receive messages:

- Tap the pick list in the center of the HotSync Options dialog and select one of the following settings:
Ignore Messages Containing
Tells your Palm III organizer to exclude the messages that meet the defined criteria and download all other messages during synchronization. In general, this filter downloads more mail during synchronization because it blocks only one defined subset of mail.

Retrieve Only Messages Containing
Tells your Palm III organizer to include only the messages that meet the defined criteria and to ignore all other messages during synchronization. This filter has the potential to block more mail during synchronization because it downloads only one subset of mail.
Defining Filter Strings

Messages are filtered based on the information contained in their To, From and Subject header fields. The information that defines what your Palm III organizer is looking for is called a filter string. You create a filter string by listing the words you want your Palm III organizer to find and separating them with either a comma or a space. Each word in the filter string is joined by an implicit OR; because of this, you should not enter connecting words such as AND or OR.

To create a more complex filter, you can define filter strings for the To, From and Subject fields simultaneously. Your Palm III organizer joins the filter strings for these fields using an implicit AND. Once again, you should not add connecting words. Your Palm III organizer will do that for you.

For example, suppose you want to receive only messages from John Smith (jsmith@aol.com) or Jack Jones (jjones@aol.com) concerning the Apollo Project. You would create the following filter strings:

**To field filter string:** jsmith@aol.com, jjones@aol.com

**Subject field filter string:** Apollo Project

Your Palm III organizer interprets this as, “Accept messages about the Apollo Project from John Smith or Jack Jones. Do not accept messages from other people. Do not accept messages from John or Jack about any other subject.”

When you define a string, note that your Palm III organizer searches for any instance of that collection of characters. For example, if you create a filter that retrieves only messages containing the string “info,” your Palm III organizer considers “info,” “rainforest” and “infonk” appropriate matches.

**To define filter strings:**

1. Tap a header field in the HotSync Options dialog.
2. Enter your filter string for the selected header field using commas or spaces to separate the words. Do not add connecting words, such as AND or OR, between words in a string.

3. If your string exceeds the length of the field, tap the name of the field to display the Notes screen for that header field. For more information about header field Notes screens, see “Creating Messages.”

4. Tap the Done button to return to the HotSync Options dialog.

5. Tap the OK button to confirm your filter strings and close the HotSync Options dialog.
High-Priority Messages
The Retrieve All High Priority setting lets you retrieve messages marked high-priority, even if those messages would have been blocked by a defined filter.

To retrieve high-priority messages:
1. Tap the Filter box in the HotSync Options dialog to display additional filter options.
2. Select the Retrieve All High Priority check box to retrieve all messages marked high-priority.
3. Tap OK to confirm your selection and close the HotSync Options dialog.

Note: This setting is applicable only if your e-mail application has the capacity to flag high-priority messages.

Truncating Messages
The Truncate feature lets you set a point at which long messages truncate when downloading to your Palm III organizer. By default, this Truncate value is 4000 characters. By truncating long messages, you reduce the time it takes to synchronize your desktop e-mail and Palm Mail as well as the amount of storage space e-mail uses on your Palm III organizer.

Note: Truncation is separate and independent from filtering.

To truncate messages:
1. Tap the Truncate button in the HotSync Options dialog to open the Truncate Options dialog.
2. Tap to select the truncation setting you want. The values range from 250 characters to 8000 characters.

Tip: If you select a low truncation value, you will have more room on your Palm III organizer to store messages.

3. Tap OK to confirm your selection and return to the HotSync Options dialog.

Mail Menu Commands

The Mail application includes menu commands to make it fast and easy to perform common file and editing tasks. This section explains the menu commands that are specific to the Mail application.

See “Using Menus” in the Basic Handbook for the Palm III Organizer for information about menu commands that are common to all of your Palm III organizer applications.

Message Menu

The Message menu varies based on whether you are viewing a message, creating a message or viewing the Message List.
New Displays the Create Message screen, where you can create a new e-mail message.

Save Draft Saves the current message as a draft and moves it to the Draft folder. Your Palm III organizer stores Draft messages until you send or delete them.

File Moves the current message to the Filed folder. Your Palm III organizer stores Filed messages until you delete them.

Send Moves the current message to the Outbox folder. Your Palm III organizer stores all sent messages in the Outbox folder until you perform a HotSync operation.

Delete Moves the current message to the Deleted folder. Your Palm III organizer stores deleted messages in the Deleted folder until you perform a HotSync operation, at which time it permanently removes deleted messages.

Purge Deleted Enables you to empty (purge) the contents of the Deleted folder. Your Palm III organizer stores deleted messages in the Deleted folder until you perform a HotSync operation. By purging deleted messages, you free up storage space on your Palm III organizer before your next HotSync operation.

Note: The Purge Deleted command displays an alert, prompting you to confirm that you want to purge all messages from the Deleted folder. If you tap Yes, all deleted messages are purged from the memory of your Palm III organizer.

Important: Messages that you purge are deleted from your desktop e-mail application during the next HotSync operation.
Options Menu
When you select the Options menu, its menu commands vary depending on whether you are creating or editing a message.

- **Font** Enables you to adjust the size of the text on the screen. This can make it easier to read the text or to fit more text in the display area.

- **Preferences** Enables you to define a specific string of text as a signature and to select whether or not your Palm III organizer displays an alert when you delete a message.

- **HotSync Options** Opens a dialog, where you can select different ways to filter messages synchronized between your desktop e-mail application and your Palm III organizer. You can create simple or complex filters to control the type of messages downloaded to your Palm III organizer. In addition, you can define separate settings for local and remote synchronizations.

- **Look Up** Opens a dialog, which contains the Address List from your Address Book. By tapping a selection, you enter that address into the To field of any message you are creating.

  **Note:** The Look Up command is available only when you are creating a message.

- **About Mail** Shows version (revision) information for the Mail application.
Chapter 7

Memo Pad

The Memo Pad provides a place to take notes that are not associated with Date Book, Address Book or To Do items.

With the Memo Pad, you can:

■ Take notes or write any kind of message on your Palm III™ connected organizer.

■ Drag and drop memos into popular computer applications like Microsoft Word, when you synchronize using Palm™ Desktop software and HotSync® technology.

■ Assign categories for memos. This enables you to quickly view just your business-related memos, personal memos or any other category that you define.

■ Quickly jot down phone numbers and other types of information. Later, you can copy and paste this information to other applications.

To open the Memo Pad:
Press the Memo Pad button on the front panel of the Palm III organizer to display the Memo List screen.

Memo Pad button
Working With Memos

A memo is where you enter, review and modify the individual Memo Pad entries. A memo can contain up to 4,000 characters; the number of memos you can store is dependent only on the memory available on your Palm III organizer.

To create a new memo:
1. Open the Memo Pad application.
2. Tap the New button to create a new memo.

Note: In the Memo List screen, you can also begin writing in the Graffiti® writing area to create a new memo. The first letter is automatically capitalized and begins your new memo.

3. Enter the text you want to appear in the memo. Use the carriage return stroke to move down to new lines in the memo.
4. After you finish, tap the Done button to return to the Memo List screen.

Reviewing Memos

Each time you create a memo, the first line of the memo appears in the Memo List screen. This makes it easy to locate and review your memos.
To review the contents of a memo:

1. Tap the text of the memo that appears in the Memo List screen to display the memo on the screen.

2. Review or edit the text in the memo.

3. Tap the Done button to save your changes to the memo and return to the Memo List screen.

Arranging Memos

The Memo Preferences dialog enables you to sort your memos alphabetically or in any order that you want.

To select a sort option:

1. In the Memo List screen, tap the icon to open the Memo Pad menus.

2. Tap Preferences from the Options menu to open the Memo Preferences dialog.

3. Tap the Sort by pick list and choose Manual or Alphabetic.

4. Tap the OK button to close the Memo Preferences dialog and activate your setting.
Manually arranging the Memo List

If you choose the Manual option for the Sort by setting, you can manually rearrange the order of the memos in the Memo List screen. When you rearrange your memos, your Palm III organizer renumbers all the memos to reflect the new order.

Note: The Manual setting of the Memo Preferences is not transferred to Palm Desktop. If you choose to display your memos alphabetically on Palm Desktop and then perform a HotSync operation, the arrangement of the memos on the Palm III organizer will still be in the order defined in the Memo Preferences setting.

To rearrange the order of your memos:
1. Select the Manual option in the Preferences dialog as described in the previous procedure.
2. In the Memo List screen, tap and drag the memo to a new location in the list. When you lift the stylus from the Palm III organizer screen, the memo appears in its new location.

Choosing a Memo Category

Categories are used to file individual memos items into groups for easy review. You can assign and edit categories by using the Categories pick list (in the upper-right corner of the screen) or the Details dialog. See “Using Categories” in the Basic Handbook for the Palm III Organizer for a complete description of categories.

Marking a Private Memo

You can designate a specific memo as “private.” When you activate the Security features, your Palm III organizer hides all private entries and you must enter a password to display them on the screen.
To mark a memo as private:
1. Tap the memo you want to mark as private to display it on the screen.
2. Tap the Details button to open the Memo Details dialog for that memo.
3. Select the Private check box.
4. Tap the OK button to close the Memo Details dialog and return to the memo screen.

Deleting a Memo
There are three ways to delete a memo: simply delete the text of the memo, use the Menu Command (as described in the “Record Menu” section in this chapter) or use the Memo Details dialog.

To delete a memo with the Memo Details dialog:
1. Tap the memo that you want to delete to display it on the screen.
2. Tap the Details button to open the Memo Details dialog.
3. Tap the Delete button to open the Delete Memo alert.
4. Tap the OK button to confirm that you want to delete the current memo.
**Memo Pad Menu Commands**

The Memo Pad includes menu commands to make it fast and easy to perform common file and editing tasks. See “Using Menus” in the *Basic Handbook for the Palm III Organizer* for information about menu commands that are common to all Palm III organizer applications.

### Record Menu

When you select the Record menu, its commands appear on screen.

- **New Memo**
  - Creates a new memo.

- **Delete Memo**
  - Opens an alert dialog, prompting you to confirm that you want to delete the current memo. Tap the OK button to delete the memo from your Palm III organizer, or tap the Cancel button to close the alert dialog and keep the memo.
  
  **Note:** By default your Palm III organizer removes the memo from the Memo List, but retains a copy of the memo and transfers it to an archive file on your computer the next time you perform a HotSync operation. To remove the memo completely, clear the Save archive copy on PC check box.

- **Beam Memo**
  - Beams the current memo to another 3Com® connected organizer through the IR port.

- **Beam Category**
  - Beams all memos in the current category to another 3Com connected organizer through the IR port.
Options Menu

When you select the Options menu, its commands appear on screen.

Font
Opens the Select Font dialog where you can choose a different font (text) style for your Memo Pad entries. See “Choosing Fonts” in the Basic Handbook for the Palm III Organizer for details.

Go to Top of Page
Moves to the top (first) line of the memo.

Go to Bottom of Page
Moves to the bottom (last) line of the memo.

Phone Lookup
Activates the Phone Lookup feature, which is described in “Using Phone Lookup” in the Basic Handbook for the Palm III Organizer.

Preferences
Activates the Memo Preferences dialog and enables you to define the sort order for your memos.

About Memo Pad
Shows version (revision) information for the Memo Pad application.
Chapter 8

Preferences

The Preferences screens enable you to customize the configuration options on your Palm III™ connected organizer.

With the Preferences screens, you can:
- Set the current date and time, the auto shut-off interval, and the system, alarm and game sounds.
- Set the display format for dates, times and numbers.
- Configure your Palm III organizer for use with a modem.
- Assign your name, phone number and other owner information to your Palm III organizer.
- Assign different applications to the buttons on the front panel of your Palm III organizer.
- Define a list of Graffiti® abbreviations.
- Calibrate the screen on your Palm III organizer.
- Configure your Palm III organizer for use with a network.

To open the Preferences screens:
1. Tap the icon in the Graffiti area to open the Applications Launcher.
2. Tap the icon to display the last Preferences screen you used.
3. Tap the pick list in the upper-right corner to select the Preferences screen you want to view.
**Buttons Preferences**

The Buttons Preferences screen enables you to associate different applications with the buttons on the front of the Palm III organizer.

For example, if you find that you seldom use the To Do List application and often use the Expense application, you can assign the To Do List button to start the Expense application.

Any changes you make in the Buttons Preferences screen become effective immediately; you do not have to change to a different screen or application.

If you assign a different application to a button, you can still access the original application using the Applications Launcher. See “Selecting Applications” in the *Basic Handbook for the Palm III Organizer*.

**To change the Buttons Preferences:**

1. Tap the pick list next to the button you want to assign in the Buttons Preferences screen to display a list of all the applications installed on your Palm III organizer.

2. Tap the application that you want to assign to the button.

**Note:** To restore all of the buttons to their factory settings, tap the Default button.

**Pen Preferences**

The Buttons Preferences screen enables you to change the Button assignment of the full-screen pen stroke. By default, the full-screen pen stroke activates the Graffiti Help dialog.
To change the Pen preferences:

1. Tap the Pen button in the Buttons Preferences screen to open the Pen dialog.

2. Tap the pick list and select one of the following settings for the full-screen pen stroke:

   - **Backlight**: Activates the backlight feature of the PalmPilot™ Personal, PalmPilot Professional Edition and Palm III organizer. You can use this setting instead of the power button to turn the backlight on and off.

   - **Keyboard**: Activates the on-screen keyboard for entering text characters.

   - **Graffiti Help**: Activates a series of screens that show the complete Graffiti pen stroke character set.
Turn Off & Lock  

Turns off and locks the Palm III organizer. You must assign a password to lock the Palm III organizer. When locked, you need to enter the password to use your Palm III organizer.

Beam Data  

Beams the current entry to another 3Com® connected organizer.

3. Tap the OK button to complete your selection and return to the Buttons Preferences screen.

HotSync® Buttons Preferences  

The Buttons Preferences screen also enables you to associate different applications with the HotSync button on the Palm III organizer cradle and the HotSync button on the optional PalmPilot Modem.

Any changes that you make in the HotSync Buttons dialog become effective immediately; you do not have to change to a different screen or application.

To change the HotSync Buttons preferences:

1. Tap the HotSync button in the Buttons Preferences screen to open the HotSync Buttons dialog.

2. Tap the pick list next to the button you want to assign to display a list of all the applications installed on your Palm III organizer.

3. Tap the application that you want to assign to each button. The default setting for each button is the HotSync setting, which means the cradle and optional PalmPilot Modem perform their normal HotSync functions.
Digitizer Preferences
The Digitizer Preferences screen activates the digitizer calibration screen. This is the same screen that appears when you start your Palm III organizer for the first time. A complete description of how to use the digitizer calibration screen appears in the “Calibrating the Screen” section in the Basic Handbook for the Palm III Organizer.

Formats Preferences
Use the Formats Preferences screen to set the display format of the dates, times and numbers on your Palm III organizer.

Country Default
The country default sets date, time, week start day, and number conventions based on geographic regions where you might use your Palm III organizer. For example, in the United Kingdom, time often is expressed based on a 24-hour clock. In the United States it is based on a 12-hour clock with an AM or PM suffix.

All your Palm III organizer applications use the Country default settings. You can, however, customize your own preferences as described in the “Time, Date, Week Start and Numbers Formats” section later in this chapter.

To set the country default:
1. Tap the country name in the Formats Preferences screen to open the Country pick list.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Formats</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset to:</td>
<td>United States</td>
</tr>
<tr>
<td>Time:</td>
<td>HH:MM am/pm</td>
</tr>
<tr>
<td></td>
<td>7:30 pm</td>
</tr>
<tr>
<td>Date:</td>
<td>M/D/Y</td>
</tr>
<tr>
<td></td>
<td>4/14/90</td>
</tr>
<tr>
<td>Week starts:</td>
<td>Sunday</td>
</tr>
<tr>
<td>Numbers:</td>
<td>1.00000</td>
</tr>
</tbody>
</table>

2. Tap the setting you want to use.
Time, Date, Week Start and Numbers Formats
The Time setting defines the format for the time of day. The time format that you select appears in all applications on your Palm III organizer.

To select the Time, Date, Week start and Numbers format:
1. Tap the Time pick list in the Formats Preferences screen, and select the format that you want for your Palm III organizer.
2. Tap the Date pick list and select the format that you want for your Palm III organizer.
3. Tap the Week starts pick list and select whether you want the first day of the week to be either Sunday or Monday.

Note: This setting controls the Day, Week and Month views in the Date Book application and all other aspects of your Palm III organizer that display a calendar.
4. Tap the Numbers pick list and select the format that you want for your Palm III organizer.

General Preferences
The General Preferences screen is where you set the time, date, auto shut-off interval and sounds for your Palm III organizer.

Setting the Current Time
Use the Set Time button in the General Preferences screen to set the current time for your Palm III organizer.

To set the current time:
1. Tap the time in the General Preferences screen to open the Set Time dialog.
2. Tap the up or down arrows to change the number for the hour.
3. Tap the minutes numbers, and then tap the arrows to adjust the settings for the current time.
4. Tap the AM or PM box to select the time of day.

**Note:** Your Palm III organizer can also display time based on a 24-hour clock. See the “Formats Preferences” section in this chapter.

5. Tap the OK button to close the Set Time dialog and return to the General Preferences screen.

### Setting the Current Date

Use the Set Date button in the General Preferences screen to set the current date for your Palm III organizer.

**To set the current date:**

1. Tap the date in the General Preferences screen to open the Set Date dialog.
2. Tap the arrows at the top to select the current year.
3. Tap a month box to select the current month.
4. Tap the current date to set the date, close the Set Date dialog and return to the General Preferences screen.
Auto-Off Delay

Your Palm III organizer has an automatic shutoff feature that turns off the power and backlight after a period of inactivity. This feature helps conserve battery power in case you forget to turn off your Palm III organizer.

If you find that your Palm III organizer shuts itself off before you finish reviewing the information on the screen, you should increase the time setting of the automatic shutoff feature.

To set the Auto-off delay:
1. Tap the Auto-off after setting in the General Preferences screen to open the pick list.
2. Tap the setting you want to use for the automatic shutoff feature. You can choose a delay of 1 minute, 2 minutes or 3 minutes.

System, Alarm and Game Sounds

Your Palm III organizer uses a variety of sounds. The System, Alarm and Game Sound settings enable you to turn the sounds on or off, and to adjust the volume level.

To set the system and alarm sounds:
1. Tap the System Sound pick list in the General Preferences screen and select the sound level.
   
   **Note:** When you turn off the System Sounds, you also turn off the “chime” tones associated with the HotSync operation.

2. Tap the Alarm Sound pick list and select the sound level.
3. Tap the Game Sound pick list and select the sound level.

   **Note:** The Game Sound setting works only with games that are programmed to respond to this setting. Older games typically do not respond to this setting.
Modem Preferences

The Modem Preferences screen enables you to define the settings for a modem directly connected to the Palm III organizer. These settings are for Palm applications that activate and use a modem.

To define the Modem Preferences:
1. Tap the TouchTone or Rotary box in the Modem Preferences screen.

<table>
<thead>
<tr>
<th>Preferences</th>
<th>Modem</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modem</td>
<td>Standard</td>
</tr>
<tr>
<td>Speed</td>
<td>57,600 bps</td>
</tr>
<tr>
<td>Speaker</td>
<td>Low</td>
</tr>
<tr>
<td>Flow Ctrl</td>
<td>Automatic</td>
</tr>
</tbody>
</table>
| String      | AT&T441A
|             | .......................... |
|             | .......................... |
|             | TouchTone™ Rotary |

Note: Select the Rotary setting only if you are certain that your telephone service does not support TouchTone dialing.

2. Tap the Modem pick list and select the type of modem connected to your Palm III organizer.

Note: If the modem connected to your Palm III organizer is not on the list, choose Hayes Basic. In most cases, the Hayes Basic settings are close enough for the Palm III organizer to function correctly.

3. Tap the Speed pick list and select the maximum speed for the modem you selected in step 2.

4. Tap the Speaker pick list and select the speaker volume that you want for the modem.

5. Tap the Flow Ctrl (Flow Control) pick list and select either Automatic, On (Xon) or Off (Xoff) flow control for the modem connection.

6. If necessary, edit the String text to change the modem setup string.
Network Preferences and Palm TCP/IP Software

The Network Preferences settings enable you to use the Palm TCP/IP software that comes with your Palm III organizer operating system. You can use the TCP/IP software to connect with Internet Service Providers (ISPs) or dial-in (remote access) servers. Because the TCP/IP software is a feature of the operating system, you configure all parameters relating to it from the Preferences application.

To use Palm TCP/IP, you must configure both the Modem Preferences and the Network Preferences settings.

Note: Modem Preferences settings enable your Palm III organizer to use an external modem (such as the PalmPilot Modem) to communicate with remote devices. For example, you can communicate with your computer if you are away on travel or your ISP server. See “Modem Preferences” in this chapter for a complete explanation on how to configure modem parameters.

After you configure both the Network and Modem Preferences, you can establish a PPP (Point-to-Point Protocol), SLIP (Serial Line Internet Protocol) or CSLIP (Compressed Serial Line Internet Protocol) connection with your ISP or dial-in server. You can do this either by using menu commands from the Network Preferences screen or by using a third-party application.

Note: Palm TCP/IP provides the ability to connect to your ISP or dial-in server, however, it does not come with any applications to view the transmitted data. Visit the Palm website (http://www.palm.com) for information on third-party applications that take advantage of TCP/IP.

Selecting a Service

Use the Service setting to choose the service template for your Internet Service Provider or a dial-in server. Service templates are a set of ISP and dial-in server configuration settings that you can create, save and reuse.
To select a service:

1. Tap the Service pick list in the Network Preference screen to display a listing of all the predefined service templates.

2. Tap the service you want to use.

Entering a User Name

The User Name setting identifies the name you use when you log into your Internet Service Provider or your dial-in server. Although this field can contain multiple lines of text, only two lines appear on the screen.

To enter a user name:

1. Tap the User Name line in the Network Preferences screen to move the cursor to that field.

2. Enter your user name.

Note: Most dial-in servers do not accept spaces in the user name.
**Entering a Password**

The Password field identifies the password you use to log into your server or ISP. Your entry in this field determines whether your Palm III organizer prompts you to enter a password each time you log into your network.

If you do not enter a password, your Palm III organizer displays the word “Prompt” in this field and asks you to enter a password during the login procedure. If you enter a password, your Palm III organizer displays the word “Assigned” in this field and does not prompt you to enter a password during the login procedure.

**Note:** If you are concerned about security, select the Prompt option and do not enter a password.

**To enter a password:**

1. Tap the Password box in the Network Preferences screen to open the Password dialog.

2. Enter the password you use to log into your server.

3. Tap OK to confirm your entry and return to the Network Preferences screen.

**Note:** The Password field updates to display the word “Assigned.”
Adding Telephone Settings
When you select the Phone field, your Palm III organizer opens a dialog where you define the telephone number you use to connect with your ISP or dial-in server. In addition, you use this dialog to define a prefix, disable Call Waiting and give special instructions for using a calling card.

Note: The phone setup dialog works correctly for AT&T and Sprint long-distance services. However, because MCI works differently, MCI customers need to put the calling card number in the Phone field and the phone number in the Calling Card field.

To enter your server phone number:
1. Tap the Phone field to open the Phone Setup dialog.

![Phone Setup Dialog]

Enter your ISP phone number here

2. Enter the phone number you use to reach your ISP or dial-in server.

3. If you need to enter a prefix or disable Call Waiting, skip to those procedures. If not, tap OK to confirm your selection and return to the Network Preferences screen.
**Entering a prefix**

A prefix is a number that you dial before the telephone number to access an outside line. For example, many offices require that you dial “9” to dial a number outside the building.

**To enter a prefix:**
1. Select the Dial Prefix check box to activate this feature.

2. Enter the prefix you need on the Prefix line.

3. Tap OK to confirm your selection and return to the Network Preferences screen.

**Disabling Call Waiting**

Call Waiting can cause your session to terminate if you receive a call while you are connected. If your telephone has Call Waiting, you need to disable this feature before logging into your ISP or dial-in server.

**To disable Call Waiting:**
1. Select the Disable call waiting check box to activate this feature.
2. Enter the code to disable Call Waiting on the Disable call waiting line.

   **Note:** Each telephone company assigns a code to disable Call Waiting. Contact your local telephone company for the code that is appropriate for you.

3. Tap OK to confirm your selection and return to the Network Preferences screen.

### Using a Calling Card

The Use Calling Card field enables you to use your calling card when dialing your ISP or Intranet server. Keep in mind that there is usually a delay before you enter your calling card number. When you define your calling card number, you need to add commas at the beginning to compensate for this delay. Each comma delays transmission of your calling card number for two seconds.

**To use a calling card:**

1. Select the Use Calling Card check box to activate this feature.

   ![Phone Setup]
   
   *Phone #: ____________________________
   ____________________________
   Check box to use a calling card
   Enter your calling card number here
   OK (Cancel)

2. Enter your calling card number on the Use Calling Card line.

   **Note:** It's a good idea to add at least three commas at the beginning of your calling card number to compensate for the cue delay.

3. Tap OK to confirm your selection and return to the Network Preferences screen.
**Connecting to your Service**

After you set your Modem and Network Preferences, establishing a connection to your ISP or dial-in server is easy.

Remember that you need a third-party application, such as a web browser or news reader, to take advantage of this connection. Check the Palm website (http://www.palm.com) for the latest information about third-party applications that support Palm TCP/IP.

**To establish a connection:**

- Tap the Connect button in the Network Preferences screen to dial the current service and display the Service Connection Progress messages.

  **Tip:** To see expanded Service Connection Progress messages, press the lower half of the Scroll button.

**To close a connection:**

- Tap the Disconnect button in the Network Preferences screen to terminate the connection between your Palm III organizer and your service.

**Creating Additional Service Templates**

You can create additional service templates from scratch or by duplicating existing templates and editing information. After you create a new or duplicate template, you can add and edit settings.

**To add a new service template:**

1. Tap the icon in the Network Preferences screen to open the menus.

2. Tap New from the Service menu to create a new service template (called Untitled) to the Service pick list and display it in the Network Preferences screen.

**To duplicate an existing service template:**

1. Tap the Service pick list in the Network Preference screen to open a list of all the predefined service templates.

2. Tap the service you want to duplicate.

3. Tap the icon to open the Network Preferences menus.

4. Tap Duplicate from the Service menu to add a copy of the service template to the Service pick list and display it in the Network Preferences screen.
Adding Detailed Information to a Service Template

If you are using one of the predefined service templates, you will probably only need to enter your user name and telephone number. If you are creating a new Service Templates, you may need to provide additional information to your ISP or dial-in server. You use the Details dialog to add additional information to a selected service template.

To select a connection type:
1. Tap the service you want to use in the Network Preferences screen.
2. Tap the Details button to open the Details dialog.
3. Tap the Connection type pick list and select one of the following connection types:
   - **PPP**  
     Point-to-Point protocol
   - **SLIP**  
     Serial Line Internet Protocol
   - **CSLIP**  
     Compressed Serial Line Internet Protocol

   **Note:** If you are not sure, try PPP; if that doesn’t work, ask your Internet Service Provider or your System Administrator for the correct connection type.

Idle Timeout

The Idle Timeout setting defines how long your Palm III organizer waits before dropping the connection with your ISP or dial-in server when you switch out of a TCP/IP application.
To set the Idle Timeout:
1. Tap the Idle Timeout pick list and select one of the following options:

- **Immediate**: Your Palm III organizer drops the connection to your ISP immediately when you switch to another application.
- **1 minute**: Your Palm III organizer waits one minute for you to open another application before it drops the connection.
- **2 minutes**: Your Palm III organizer waits two minutes for you to open another application before it drops the connection.
- **3 minutes**: Your Palm III organizer waits three minutes for you to open another application before it drops the connection.
- **Power Off**: Your Palm III organizer keeps your PPP or SLIP connection until you power off your Palm III organizer (or until it times out). This option works best with the PalmPilot Modem.

2. Tap the OK button to confirm your selection and return to the Network Preferences screen.

Defining Primary and Secondary DNS

The Domain Naming System (DNS) is a mechanism in the Internet for translating the names of host computers into IP addresses. When you enter a DNS number (or IP address), you are identifying a specific server that handles the translation services.

Each IP address has four sections, separated by periods. In the Details dialog, you enter each section separately. Each section of an IP address is made up of a number from 0 to 255; numbers are the only allowable characters in this field.

**Note:** Ask your Internet Service Provider or System Administrator for the correct Primary or Secondary DNS IP numbers.

**Tip:** Many systems do not require that you enter a DNS. If you are not sure, leave the DNS field blank.
To enter a primary and secondary DNS:
1. Select the Query DNS check box.
2. Tap the space to the left of the first period in the Primary DNS field, then enter the first section of the IP address.
   
   **Note:** Each section must be a number from 0 to 255.
3. Tap the second section of the Primary DNS field, then enter the second section of the IP address.
4. Tap the third section of the Primary DNS, then enter the third section of the IP address.
5. Tap the last section of the Primary DNS field, then enter the last section of the IP address.
6. Repeat steps 1 through 4 for the Secondary DNS number.
7. Tap the OK button to confirm your selection and return to the Network Preferences screen.

**IP Address**

Everyone who logs on to the Internet needs to have a unique identifier (an IP address), whether permanent or temporary. Some networks dynamically assign a temporary IP address when clients log in. The IP Address field lets you identify whether your network provides automatic (dynamic) temporary IP addressing.

**Note:** If your IP address is permanently assigned, you will need to get that information from your System Administrator. If you are not sure, select Automatic.

To identify dynamic IP addressing:
- Select the IP Address check box to activate this option.
To enter a permanent IP address:
1. Clear the IP Address check box to disable this option and display a permanent IP address field below the check box.
2. Tap the space to the left of the first period then enter the first section of the IP address.
   Note: Each section must be a number from 0 to 255.
3. Tap and enter the remaining sections of the IP address.
4. Tap the OK button to confirm your selection and return to the Network Preferences screen.

Creating a Login Script
A login script is a series of commands, similar to an autoexec.bat file, that automates logging into your ISP. You can create login script files by selecting commands from the Command pick list in the Login Script dialog. Some commands from the Command pick list, such as Send, require you to supply additional information. Those commands have a parameter field so that you can add the necessary data.

Note: You can also use non-ASCII and literal characters in your login script. See “Appendix C: Non-ASCII Characters for Login Scripts” for additional information.

To create a login script:
1. Tap the Script button in the Details dialog to open the Login Script dialog.
2. Tap the End pick list to open the Command list.
3. Tap the command you want from the Command list. If the command requires additional information, a field appears to the right of it for you to enter the information. The following commands are available:

**Wait For**
Tell your Palm III organizer to wait for specific characters from the TCP/IP server before executing the next command.

**Send**
Transmits specific characters to the TCP/IP server to which you are connecting.

**Send CR**
Transmits a carriage return or LF character to the TCP/IP server to which you are connecting.

**Send User ID**
Transmits the User ID information entered in the User ID field of the Network Preferences screen.

**Send Password**
Transmits the Password entered in the Password field of the Network Preferences screen. If you did not enter a password in the Password field, this command prompts you to enter one. The Password command is usually followed by a Send CR command.

**Delay**
Tells your Palm III organizer to wait a specific number of seconds before executing the next command in the login script.

**Get IP**
Reads an IP address and uses it as the IP address for your Palm III organizer. This command is used with SLIP connections.

**Prompt**
Opens a dialog and prompts you to enter text of some kind (for example, a password or a security code).

**End**
Identifies the last line in the login script.

4. Repeat steps 2 and 3 until the login script is complete.

5. Tap OK to confirm your selection and return to the Details dialog.
Deleting a Service Template

There is only one way to delete a service template: use the Delete command from the Service menu.

To delete a service template:
1. Tap the Service pick list in the Network Preference screen to open a list of available service templates.
2. Tap the service you want to delete.
3. Tap the icon to open the menus for the Network Preferences screen.
4. Tap Delete from the Service menu to display the Delete Service alert.
5. Tap the OK button to confirm that you want to delete the service template.

Network Preferences Menu Commands

The Network Preferences screen includes menu commands to make it fast and easy to create and edit service templates. This section explains the menu commands that are specific to the Palm TCP/IP application.

See “Using Menus” in the Basic Handbook for the Palm III Organizer for information about menu commands that are common to all of your Palm III organizer applications.

Service Menu

When you select the Service menu, its commands appear on screen.

- **New**
  Creates a new (empty) service template and adds it to the Service pick list.

- **Delete**
  Deletes a selected service template from the Service pick list.

- **Duplicate**
  Copies the selected service template and adds it to the Service pick list.
Options Menu
When you select the Options menu, its command appears on screen:

Service Edit Options
View Log

View Log Displays the Network Log screen

TCP/IP Troubleshooting
If you are having a problem establishing a network connection using Palm TCP/IP, check this section and try the suggestions listed.

Displaying expanded Service Connection Progress messages
It’s helpful to identify at what point in the login procedure the connection fails. An easy way to do this is to display the expanded Service Connection Progress messages. Expanded Service Connection Progress messages describe the current stage of the login procedure. Press the lower half of the Scroll button at any point during login to display these messages.

Viewing the Network Log
If viewing the expanded Service Connection Progress messages does not give you enough information to find out why you cannot connect to your ISP or dial-in server, take a look at the Network Log. The Network Log lists all of the communication that occurs between your modem and your dial-in server during the login procedure. The information in the Network Log can help your ISP or your System Administrator pinpoint where the login procedure communication fails and why.

To view the Network Log:
1. From the Network Preferences screen, tap View Log from the Options menu to display the Network Log screen.
2. Tap the up and down arrows of the scroll bar to see the entire Network Log.
3. After you finish, tap the Done button to return to the Network Preferences screen.
Adding a DNS Number

If your ISP or dial-in server requires a DNS number and you did not enter that information in the Network Preferences screen, it will appear that you successfully logged into your network. However, when you try to use an application or look up information, the connection fails. If this occurs, try adding a DNS number. Ask your ISP or your System Administrator for the correct Primary and Secondary DNS IP numbers.

Owner Preferences

The Owner Preferences screen enables you to record a name, company name, phone number or any other information that you want associated with your Palm III organizer.

If you use the Security application to turn off and lock your Palm III organizer with a password, information that you put in the Owner Preferences displays the next time you turn on your Palm III organizer. See “Security” for more information.

To enter the Owner Preferences:

- Enter the text that you want to associate with your Palm III organizer in the Owner Preferences screen. If you enter more text than will fit on one screen, a scroll bar automatically appears on the right side of the screen.

If you assign a Password (with the Security application), the information in the Owner Preferences screen “locks” and cannot be changed. In this case, an Unlock button appears at the bottom of the screen.
To unlock the Owner Preferences screen:
1. Tap the Unlock button in the Owner Preferences screen to open the Unlock Message dialog.
2. Enter the password that you defined in the Security application, and tap the OK button.

ShortCuts Preferences
The ShortCuts Preferences screen enables you to define abbreviations for entering text with Graffiti. This section describes how to create, edit and delete a shortcut. For details on the use of ShortCuts, see the “Graffiti ShortCuts” section in “Writing With the Stylus” in the Basic Handbook for the Palm III Organizer.

Creating a ShortCut
You can create a ShortCut for any words, letters or numbers. All ShortCuts you create appear on the list in the ShortCut Preferences screen. All the ShortCuts are available in any of your Palm III organizer applications and are backed up on your computer when you perform a HotSync operation.

To create a ShortCut:
1. Tap the New button in the ShortCut Preferences screen to open the ShortCut Entry dialog.
2. On the ShortCut name line, enter the letters you want to use to activate the ShortCut.
3. Tap the ShortCut Text area and enter the text that you want to appear when you write the ShortCut characters.

Tip: You may want to add a space (space character) after the last word in your ShortCut text. This way, a space automatically follows the ShortCut text.
4. Tap the OK button to close the ShortCut Entry dialog and define your ShortCut.

**Tip:** To use a ShortCut, draw the ShortCut stroke followed by the ShortCut characters. When you draw the ShortCut stroke, the ShortCut symbol appears at the insertion point to show that you are in ShortCut mode.

**Editing a ShortCut**
After you create a ShortCut, you can modify it at any time.

**To edit a ShortCut:**
1. Tap the ShortCut you want to edit in the ShortCuts Preferences screen.
2. Tap the Edit button to display the ShortCut Name and ShortCut text in the ShortCut Entry dialog.
3. Make the changes you want and tap the OK button.

**Deleting a ShortCut**
If you no longer need a ShortCut, you can delete it from the list of ShortCuts.

**To delete a ShortCut:**
1. Tap the ShortCut you want to delete in the ShortCuts Preferences screen.
2. Tap the Delete button to display an alert dialog.
3. Tap the Yes button to confirm that you want to delete your ShortCut.
Chapter 9

Security

Your Palm III™ connected organizer comes with a Security application so that unauthorized users cannot view the entries you wish to protect.

With the Security application you can:

- Hide record entries you mark as “Private.” You can hide private entries with or without a password. Without a password, private entries are hidden until you set the Security application to show them. With a password, you must enter the password to view the private entries.
- Turn off and lock your Palm III organizer so that it does not operate until you enter the correct password.

To open the Security application:

1. Tap the \[ icon to open the Applications Launcher.
2. Tap the \[ icon to display the Security screen.
Assigning a Password
You can assign a password to protect your private entries and to lock your Palm III organizer.

To assign a password:
1. Tap the Password box in the Security screen to open the Password dialog.

2. Enter the password that you want for your Palm III organizer.

3. Tap the OK button to open a confirmation dialog.

4. Enter the same password a second time, and tap the OK button to assign that password to your Palm III organizer.
Hiding Private Entries

You can hide the entries that you mark as private. If you assign a password, you must enter it to show entries you mark as private. Note that your Palm III organizer merely hides the entries; it does not delete them.

To hide Private entries:

1. Tap the Hide box in the Security screen to open the Hide Records dialog.

2. Tap the Hide box to hide entries you mark Private and to close the Hide Records dialog.
**Showing Private Entries**

After you hide Private entries, you can use the Security application to display them again.

**To show Private entries:**

1. Tap the Show box in the Security screen.

   If you did not assign a password, your Private entries should be visible. If you did assign a password, the Show Private Records dialog appears.

2. Enter your password.

3. Tap the Show box to close the Show Private Records dialog and display Private entries in your Palm III organizer applications.

**Locking Your Palm III Organizer**

You can also lock your Palm III organizer, so that you need to enter your password to operate it.

**Important:** If you lock your Palm III organizer as described in the following procedure, you need to enter the exact password to re-activate your Palm III organizer. If you forget the password, you need to use the reset button to resume using your Palm III organizer. Using the reset button deletes all the entries in your Palm III organizer; however, you can restore all synchronized data at the next HotSync® operation. For information about how to use the reset button, see “Resetting Your Palm III Organizer” in the Basic Handbook for the Palm III Organizer.
To lock your Palm III organizer with a password:

1. Use the HotSync application to synchronize the data between your Palm III organizer and your computer. See “HotSync” for information about how to use the HotSync application.

2. Assign a password as described in “Assigning a Password” earlier in this chapter.

3. Tap the Turn Off & Lock Device button in the Security screen to open the System Lockout dialog.

4. Tap the Off & Lock button to turn off the power for your Palm III organizer.

5. Start your Palm III organizer and enter the password.

Changing or Deleting a Password

Once you define a password for your Palm III organizer, you can change or delete it at any time. You must enter the current password before you can change or delete it.

To change or delete your password:

1. Tap the Assigned box in the Security screen to open the Password dialog.
2. Enter the current password.
3. Tap the OK button to open a dialog that prompts you for a new password.

4. To change the password, enter the new password and tap the OK button. To delete the password, tap the Delete button.

**Recovering from a Forgotten Password**

If you forget your password, you can delete the password from your Palm III organizer. Deleting a forgotten password also deletes all entries and files marked as Private.

**Important:** If you synchronize with your computer before deleting a forgotten password, your Palm III organizer restores your private entries the next time you perform a HotSync operation, but it does not restore the password.

**To delete a forgotten password:**
1. Tap the Forgotten Password button in the Security screen to open the Delete Password dialog.
2. Tap the Yes button to delete the password, as well as all records and entries marked “Private.”
Chapter 10

To Do List

The To Do List is a convenient place to create reminders and prioritize the things that you have to do.

With the To Do List, you can:

- Make a quick and convenient list of things to do.
- Assign a priority level to each task.
- Assign a due date for any or all of your To Do items.
- Assign a category for any, or all of your To Do items. You can then view your To Do List based on category (Business, Personal, etc.).
- Sort your To Do items either by due date, priority level or category.
- Attach notes to individual To Do items for a description or clarification of the task.

Opening the To Do List

Press the To Do List button on the front panel of the Palm III™ connected organizer to display the To Do List screen.
Working With To Do Items

A To Do item is a reminder of some task that you have to complete. Your Palm III organizer gives you control over the appearance, level of detail and the sort order of To Do items.

To create a To Do item:
1. Tap the New button in the To Do List screen to add an item to the list.

2. Enter the text you want to appear in the To Do item. The text can be longer than one line.

3. Tap anywhere on the screen to de-select the To Do item.

Note: If no To Do item is currently selected, writing in the Graffiti® writing area automatically creates a new To Do item.

Setting Priority

Priority settings for To Do items enable you to arrange the tasks in your To Do List according to relative levels of importance. The default setting for the To Do List is to arrange To Do items by priority and due date, with priority 1 items at the top. If you have a number of To Do items in your list, changing an item’s priority setting may move its position in the list.

Note: When you create a new To Do item, its Priority is automatically set to level “1,” the highest (most important) level. However, if you select a To Do item first, the new item appears beneath the selected item with the same priority as the selected item.

Using the Priority feature is optional.
To set a Priority level for a To Do item:
1. Tap the Priority number on the left side of the To Do item to open the Priority pick list.

2. Tap the Priority number that you want to set for the To Do item (1 is most important and 5 is least important).

Note: You can also change the Priority setting for a To Do item with the To Do Details dialog described later in this chapter.

Checking Off a To Do Item
The To Do List makes it easy to mark tasks as you complete them. You can set the To Do List to record the date that you complete the To Do item and you can choose to show or hide complete To Do items. See “To Do Show Options” later in this chapter.

To check off a To Do item:
- Tap the check box on the left side of the To Do item.
To Do Item Details

The To Do Item Details dialog enables you to change individual To Do item settings.

To activate the To Do Item Details dialog:
1. Tap anywhere on the text of a To Do item in the To Do List screen.
2. Tap the Details button to open the To Do Item Details dialog.

The following sections describe the features and settings that are available in the To Do Item Details dialog.

Choosing a To Do Category
Categories can help you file individual To Do items into groups for easy review. You can assign and edit categories by using the Categories pick list in the Details dialog (see “Using Categories” in the Basic Handbook for the Palm III Organizer for a complete description of categories).

Setting a Due Date
You can associate a due date with any To Do List item. You can also sort the items that appear in the list based on their due date.

To set a Due Date for a To Do List Item:
1. Tap the “No Date” text in the Details dialog to open the Due Date pick list.
2. Tap the Due Date that you want to assign the To Do item. The following choices are available:

   - **Today**: Assigns the current date.
   - **Tomorrow**: Assigns tomorrow’s date.
   - **One week later**: Assigns the date exactly one week from the current date.
   - **No Date**: Removes the due date from the To Do item.
   - **Choose date**: Opens the Due Date dialog where you can chose any due date that you want for the To Do item.

3. Tap the OK button to confirm your selection and close the To Do Details dialog.

   **Note:** If you turn on the Show Due Dates option in the To Do Show options dialog, you can tap directly on the due date in the To Do List to open the pick list shown in step 2.

### Deleting a To Do Item

There are three ways to delete a To Do item: simply delete the text of the To Do item, use the Menu Command (as described in the “Record Menu” section in this chapter), or use the To Do Details dialog.

**To delete a To Do item with the To Do Details dialog:**

1. Tap anywhere in the text area of the To Do item that you want to delete.
2. Tap the Details button to open the To Do Item Details dialog.
3. Tap the Delete button to open the Delete To Do alert dialog.
4. Tap the OK button to confirm that you want to delete the To Do item.
**To Do Show Options**

The Show Options dialog enables you to control the appearance of the To Do List application.

**To change the Show Options settings:**
1. Tap the Show button in the To Do List screen to open the To Do Preferences dialog.

2. Select any of the following settings:

   - **Sort by**: Enables you to sort the To Do items in one of the following ways:
     - Priority, Due Date
     - Due Date, Priority
     - Category, Priority
     - Category, Due Date

   - **Show Completed Items**: Displays your complete To Do items in the To Do List. If you turn off this setting, your To Do items disappear from the list when you complete (check) them.

   - **Show Only Due Items**: Shows only the To Do items that are currently due, past due or have no due date specified in the To Do List. When this setting is active, To Do items that are not yet due do not appear in the list until their due date.
3. Tap the OK button to confirm your selections and close the dialog.

**To Do List Menu Commands**

The To Do List includes menu commands to perform common file and editing tasks. See “Using Menus” in the *Basic Handbook for the Palm III Organizer* for information about menu commands that are common to all Palm III organizer applications.

**Record Menu**

When you select the Record menu, its commands appear on screen.

- **Delete Item**
  - Opens an alert dialog, prompting you to confirm that you want to delete the current To Do item. You must select a To Do item before you can delete it. Tap the OK button to delete the To Do item from your Palm III organizer, or tap the Cancel button to close the alert dialog and keep the To Do item.
Note: By default your Palm III organizer removes the item from the To Do list, but retains a copy of the item and transfers it to an archive file on your computer the next time you perform a HotSync® operation. To remove the event completely, clear the Save archive copy on PC check box.

**Attach Note**
Opens the To Do Note dialog where you can create a note for the current To Do item.

**Delete Note**
Opens an alert dialog, prompting you to confirm that you really want to delete the note attached to the To Do item. You must select a To Do item before you can delete its note. Tap the Yes button to delete the Note from the memory of your Palm III organizer, or tap the No button to close the alert dialog and return to the To Do List.

**Purge**
Deletes To Do items that you mark (check) as complete. All complete To Do List items remain in the To Do List until you use this command. The default setting is “Save archive copy on PC.” This removes complete To Do items from the To Do List, but retains copies and transfers them to an archive file on your computer the next time you perform a HotSync operation.

**Beam Item**
Beams the current To Do item to another 3Com® connected organizer through the IR port.

**Beam Category**
Beams all To Do Items in the current category to another 3Com connected organizer through the IR port.
Options Menu
When you select the Options menu, its commands appears on screen.

Font
Displays the Select Font dialog where you can choose a different font (text) style for your Address Book entries. See “Choosing Fonts” in the Basic Handbook for the Palm III Organizer for details.

Phone Lookup
Activates the Phone Lookup feature, which is described in “Using Phone Lookup” in the Basic Handbook for the Palm III Organizer.

About To Do List
Shows version (revision) information for the To Do List application.
Appendix A

Expense Templates

This appendix provides illustrations of the four expense templates that come with the Palm™ Desktop software. You may use or modify any of these templates when creating expense reports with data from the Expense application.

Sample 1
Sample 2
Sample 3
Sample 4

<table>
<thead>
<tr>
<th>No.</th>
<th>EMPLOYEE NAME</th>
<th>EMP NO.</th>
<th>PHONE</th>
<th>PROJECT</th>
<th>DEPT.</th>
<th>WEEK-BEG.</th>
<th>AMOUNT</th>
<th>TOTAL</th>
<th>VENDOR</th>
<th>VENDOR CODE</th>
<th>VENDOR NAME</th>
<th>ADDRESS</th>
<th>CITY</th>
<th>STATE</th>
<th>ZIP</th>
<th>PHONE</th>
<th>TEL</th>
<th>FAX</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

WEIGHT

<table>
<thead>
<tr>
<th>DATES</th>
<th>DEPARTMENT</th>
<th>COMMENTS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

VENDOR

<table>
<thead>
<tr>
<th>VENDOR CODE</th>
<th>VENDOR NAME</th>
<th>ADDRESS</th>
<th>CITY</th>
<th>STATE</th>
<th>ZIP</th>
<th>PHONE</th>
<th>TEL</th>
<th>FAX</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

PLACED ORDER DATE

<table>
<thead>
<tr>
<th>BUSINESS PURPOSE</th>
<th>JANUARY</th>
<th>FEBRUARY</th>
<th>MARCH</th>
<th>APRIL</th>
<th>MAY</th>
<th>JUNE</th>
<th>JULY</th>
<th>AUGUST</th>
<th>SEPTEMBER</th>
<th>OCTOBER</th>
<th>NOVEMBER</th>
<th>DECEMBER</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Appendix B

Creating a Custom Expense Report

This section explains how to modify existing Expense application
templates, and how to create your own custom expense report
templates for use with the Expense application.

Note: This section assumes that you are familiar with Microsoft
Excel or a similar spreadsheet application. If you are not
familiar with Microsoft Excel, consult your company’s
Information Services department or another experienced user.

About Mapping Tables

Before creating or modifying an Expense template, it’s important to
understand the function of Palm™ Desktop’s Expense application. In
simple terms, the Expense application is designed to move Expense
data from your Palm III™ connected organizer into a Microsoft Excel
spreadsheet.

Each Expense item stored in your Palm III organizer represents a
group of related data. The following data can be associated with an
expense item:

- Category
- Payment Currency
- Date
- Vendor
- Expense Type
- City
- Amount
- Attendees
- Payment Method
- Note

When you perform a HotSync® operation between your Palm III
organizer and the Palm Desktop on your computer, the Expense data
is stored on your computer (in a file named Expense.txt). When you
open the Expense application in Palm Desktop, an Excel macro starts,
and populates an expense template with your data based on the rules
specified in a spreadsheet file named Maptable.xls.

The Maptable.xls file is an editable spreadsheet that functions as a
“mapping table.” The function of the mapping table is to guide the
Excel macro in extracting the Expense data. The mapping table tells
the Excel macro how large the spreadsheet is and provides the data-
cell layout of the Excel template used for the Expense Report.
Customizing Existing Sample Templates

Four sample Expense Report templates come with Palm Desktop. These templates are stored in the Templates folder (which is in the same folder as the Palm Desktop application).

If the layout of one (or more) of these templates is appropriate for your reporting needs, you can easily customize the templates with your company name and other information.

To customize a sample Expense Report template:
1. Make a backup copy of the contents of the Templates folder.

2. Double-click the name of the sample template you want to modify to open it in Microsoft Excel.

3. Make any changes that you want to the names (or other information) in the sample template.

   **Important:** Do not insert rows or columns in the sample template. Doing so changes the way your Expense data maps to the template and causes errors. If you want to move the cells to a different location or add or delete rows or columns, you will have to make changes to the Maptable.xls file.

   **Note:** You can insert your own company logo without changing the Maptable.xls file. However, if you change the file name, you need to make a corresponding change in the Maptable.xls file.

   You can also rename cells without changing the Maptable.xls file — provided that the expense type corresponds to your Palm III organizer data. For example, you can change “Snack” to “Munchies” — and then all items entered on your Palm III organizer as “Snack” will map to the cell(s) labeled “Munchies.”
4. Choose Save As from the File menu to open the Save As dialog.

5. Click the Save as type drop-down list and choose Template (*.xlt).


   **Note:** If you *do not* need to change the Maptable.xls file, save the template file with its *original file name* (e.g., Sample2.xlt).

   If you *do* need to change the Maptable.xls file, give your modified template a unique name. Be sure to use the .xlt file suffix, which defines the file as a Microsoft Excel template.

7. Click the Save button to save your modified template and make it available for future use.

   **Note:** If you need to modify the Maptable.xls file, you must do this before you can use the modified template with your Expense data. To modify the Maptable.xls file for your new template, see “Programming the Mapping Table” later in this appendix. *Read all of the sections of this appendix before making changes to the Maptable.xls file.*

---

**Determining the Layout of the Expense Report**

This section describes the layout considerations for the Expense Report and explains the terms used for creating the report.

**Labels**

There are two kinds of labels that you need to define for your report: day/date and expense type. Each kind of label can be either Fixed or Variable. A Fixed label means that the label *always* appears as a header at the beginning of a row or column. If a label is not Fixed, it is variable.

For example, a list table of expenses could have variable labels in the rows for day/date, and variable labels in the columns for expense type. In this case, neither day/date–or expense type information would be “fixed” (as a header). Instead, the date and expense type information would be filled into the cells of the spreadsheet as appropriate.

Examples of both Fixed and Variable labels appear in the sample expense templates.
Sections
A Section is an area of the report that has common formatting. It is common for an Expense report to have more than one Section. For example, the following sample Expense Report named Sample3.xlt contains several Sections.

Because your Expense data maps to row and column areas of your final report, different Sections require different definitions for the data mapping. To create additional Sections with different mapping, you create corresponding additional lines to the mapping table file named Maptable.xls. This procedure is explained later in this appendix.

If a section contains cells for prepaid (company paid) expenses, you need to create an additional line in the mapping table for “prepaid.” This will count as an additional section in the mapping table. The only data that differs in the prepaid section (from the non-prepaid section) is the row/column numbers for the expense type.

Analyzing Your Custom Expense Report
If you already have a custom Excel expense report, you can use it with a modified mapping table. However, before you can create a Maptable.xls file that corresponds to your custom Expense Report, you must first analyze the characteristics of your report.
Perform the following before you begin a custom mapping table:

- Print a copy of your custom expense report. Activate the Row and Column Headings option in the Sheet settings of the Page Setup command. This enables you to quickly determine the size of the Section(s), as well as the numbers for the start rows and columns.
- On the printed copy, identify the data Sections. A Section is an area of data with common row and column formatting. A yellow highlighter marking pen can make it easy to see the Sections as you work with programming the mapping table. Your custom Expense Report can contain any number of Sections, and the same data can be repeated in any Section.
- On the printed copy, identify the type of Labels that apply to each Section. Each Section can have only one kind of Fixed or Variable Label for rows. Likewise, each Section can have only one kind of Fixed or Variable Label for columns.
- Place a copy of your custom Expense Report in the Templates folder (in the Palm Desktop directory). Change the file name so it has the file extension .xlt (which defines it as a Microsoft Excel Template). Make a note of the exact file name so it can be defined in the mapping table file.

Programming the Mapping Table

Once you have analyzed the components of your custom Expense Report, you can program the mapping table to fill the report with data from the Palm III organizer.

To program a new custom mapping table:

1. Open a copy of the Maptable.xls file in Microsoft Excel.

   **Note:** This file is located in the same folder as the Palm Desktop application. Make a backup copy of this file before you make your modifications.

2. **Mapping a new template.** Scroll to where you find the name of the original template that you chose for your modifications. The name of the template will appear in column B of the Maptable.xls file, next to the cell highlighted in green that reads “Template Name:”. If you did not modify an existing template, move to any table in the Maptable.xls file.

3. Select all the *rows* associated with the template name. To select the rows, click and drag on the row numbers (left side), so they appear highlighted.
4. Choose Copy from the Edit menu.

5. Scroll down to a blank area of the Maptble.xls file (below the rows used for Sample4.xlt), and click on a row number to select a blank row.

6. Choose Paste from the Edit menu. A copy of the rows you selected in step 3 is pasted into the Maptble.xls file.

7. **Name the table.** In the cell immediately to the right of the cell entitled Template Name, enter the *exact* file name of your custom Expense Report template.

8. **Define the number of Sections.** Each row in a table defines how your Palm III organizer data will be placed in a Section of your custom Expense Report. Note that the prepaid portion of a section has its own row and counts as a separate section for map table purposes, even though it is not a separate section in your template.
You may add or delete rows as necessary so that the total number of rows corresponds to the number of Sections in your custom Expense Report. To clear all of the existing settings in a row, click to select the row and press Ctrl+Delete. Name each row to correspond to a Section of your custom Expense Report.

9. **Determine the Label settings.** The orientation of the data fields (Row, Column) appears in the yellow section of the table.

![Sample Table]

Determine whether the **Rows** will contain expense or date information, and place an “x” in the appropriate cell. When you do this, you also define whether the label is Fixed or Variable. You can place only one “x” in the Row section (columns 2–5).

Determine whether the **Columns** will contain expense or date information, and place an “x” in the appropriate cell. When you do this, you also define whether the label is Fixed or Variable. You can place only one “x” in the Column section (columns 6–9).

10. **Define the dimensions of the Section.** The dimensions of the Section appear in the green columns (10–13).

![Dimension Table]

- **# of Rows**
  - Represents the total number of rows in the Section, excluding any header or total rows. In other words, this includes only the number of rows in the Section where your Palm III organizer data will be placed.

- **# of Columns**
  - Represents the total number of columns in the Section, excluding any header or total columns. In other words, this includes only the number of columns in the Section where your Palm III organizer data will be placed.

- **Start Row**
  - Is the number of the first row of the Section that will be filled with your Palm III organizer data.

- **Start Column**
  - Is the number of the first column of the Section that will be filled with your Palm III organizer data.
11. **Define the Dates and Intervals.** The dates and intervals between dates appears in the light blue columns (14–17).

<table>
<thead>
<tr>
<th>Date</th>
<th>Intervals Between</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date</td>
<td>Dates</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

In the **Date** cell, enter the row or column number where all the date information will be placed.

In the **Dates** cell, enter the number of blank columns (or rows) separating the date fields. If there are no blank columns (or rows) between date entries, leave this number set to zero.

In the **Start Day** cell, enter the day of the week that starts the expense reporting period. Enter a three-character abbreviation for the day (e.g., Sun, Mon, Tue).

In the **Day** cell, enter the row or column number where all the day information will be placed. If the dates are in a row, enter the row number. If the dates are in a column, enter the column number.

12. **Define whether the Section is in list format.** This setting appears in the light purple columns (18–19).

<table>
<thead>
<tr>
<th>Listing Format</th>
<th>Expense Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>1</td>
</tr>
</tbody>
</table>

If the Section will present the data in a list format, enter the word “yes”. Otherwise, enter the word “no”. The following diagram shows data presented in a list format:

Only if your section is in list format: In the **Expense Type** cell, enter the number of the row or column where the expense description will be placed. Expense amounts can be entered in several different columns or rows if required by your template. **Expense type labels** must all appear in the same column.
13. Enter the row or column numbers for the expense types that appear in the Section. These settings appear in the aqua columns (20–48).

For these settings, simply enter the row or column number for the expense types that you want to appear in the Section. Note that the same row or column number can be used more than once. An example of this would be meals that encompass breakfast, lunch, dinner and snacks. In the previous example, all expense items would be populated into row/column 4 of the custom Expense Report.

14. Complete the table. All of the remaining columns (49–57) in the table are used to define the column or row number that corresponds to the description.

15. Mark a Section for prepaid expenses (yellow column). If a row in the map table is for prepaid (company paid) expenses, type a “yes” in the cell on that Section’s row. Type “no” in all the cells of this column that do not pertain to prepaid expenses.

16. Repeat steps 9 through 15 for each Section that you have defined for your custom Expense Report.

17. Map Expense Report Options dialog (magenta section). The Expense Report Options dialog has five fields where you can fill in data for the header on your expense report. Use this section to specify the row and column on your template where this information will be mapped.

Because header data is not related to any particular Section, you have to fill in only one row. If the item does not appear on your template, leave these cells blank.
Using Applications Other Than Microsoft Excel

You can use applications other than Microsoft Excel (such as Lotus 1-2-3 or Quattro Pro) to open and manipulate the Expense data on your computer. The data file is named “Expense.txt,” and is stored in the Expense folder, within the folder containing the Palm III organizer user data.

Expense data in the Expense.txt file is in tab-delimited format.

Expense File Details

The Expense.txt file contains four groups of data. It will be easier to see these four distinct groups of data if you open the file with a spreadsheet application.

- **Trips**
  Shows the number of Expense application categories, and lists each one followed by an “end” statement.

- **Currency**
  Shows how many currencies were used for the Expense data, and lists the countries that correspond to that currency.

- **Trip**
  Shows the number of expenses by category, and lists the expenses for each category.

- **Expenses**
  Shows the total number of expenses, and lists them chronologically.
Appendix C

Non-ASCII Characters for Login Scripts

The following information enables you to create custom login scripts that require non-ASCII characters. It is provided for advanced users who understand the use and requirements of such characters in a custom login script.

Use of ^char

You may use the caret ( ^ ) to transmit ASCII command characters. If you send ^char, and the ASCII value of char is between @ and _, then the character is automatically translated to a single-byte value between 0 and 31. For example, ^M is converted to a carriage return. If char is a value between a and z, then the character sequence is translated to a single-byte value between 1 and 26. If char is any other value, then the character sequence is not subject to any special processing.

For example, the string “Joe^M” transmits Joe, followed by a carriage return.

Carriage Return and Line Feed

You may include carriage return and line feed commands as part of the login script, when entered in the following format:

<cr> Sends or receives a carriage return
<lf> Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe followed by a carriage return and line feed from the remote computer before executing the next command in the script.
Literal Characters

The backslash (\) character defines that the next character is transmitted as a literal character, and is not subject to any special processing ordinarily associated with that character.

Examples:

\^ Includes a caret as part of the string
\< Includes a < as part of the string
\\ Includes a backslash as part of the string
**Index**

**A**
- Adding
  - Address Book entries 2
  - Date Book entries 18
  - Expense entries 33
  - To Do items 134
- Address
  - mail message 70
- Address Book
  - beaming 8
  - business card 8
  - categories 6
  - creating entry 2
  - deleting entries 4
  - editing entry 4
  - entry details 7
  - features 1
  - list by company 7
  - lookup entries 5
  - menu commands 10
  - opening 1
  - phone numbers 6
- Alarm
  - setting 22
- Alarm Sounds 108

**Applications**
- Address Book 1
- Date Book 17
- Expense 33
- Memo Pad 93
- security 127
- To Do List 133

**Attendees** 37
- Automatic fill 45
- Auto-Off Delay 108

**B**
- Backlight
  - pen stroke 103
- Batteries
  - auto-off delay 108

**Beaming**
- Address Book categories 9
- Address Book entries 9
- business card 9
- Date Book entries 30
- pen stroke 104
- To Do List 140
- Blind Carbon Copy 72
  - defining 73
- Business Card
  - beaming 9
  - selecting 8
- Button Preferences 102
  - pen 102

**C**
- Calculator
  - buttons 14
  - clear entry 14
  - memory 14
  - menu commands 15
  - opening 13
  - recent calculations 15
- Call Waiting
  - disabling 114
- Calling Card
  - use in phone settings 115
- Categories
  - Address Book entries 6
  - beaming 9, 140
  - Expense 36
  - memos 96
  - To Do List 136
- Changing
  - Address Book entries 4
- Conduits 54
- Confirm Delivery 72
- Confirm Read 72
- Connecting
  - service templates 116
  - to server or ISP 116
- Connection Type 117
Creating
  Address Book entries 2
  Date Book entries 18
  Expense entries 33
  Mail messages 68
  memos 94
  to do items 134

D
Date
  Expense item 35
  in message list 80
  scheduling event 20
  setting 107
  to do item 136
Date Book
  alarm 22
  beaming entries 30
  deleting events 25
  event conflicts 28
  event date 20
  event duration 18
  event start time 18
  features 17
  menu commands 29
  month view 28
  opening 17
  private events 25
  repeat event 23
  rescheduling events 22
  scheduling event 18
  selecting date 20
  switching views 26
  untimed event 18, 21
  week view 26
Deleted
  messages in folder 79
  purging messages 79
Deleting
  Address Book entries 4
  Date Book events 25
  memos 97
  messages 78
  password 131

E
service templates 122
To Do items 137
Details
  Address Book 7
  Expense 35
  To Do items 136
Digitizer 105
DNS 118
Draft Messages 77
Editing
  Address Book entries 4
  Editing Unsent Messages 76
Entering
  Date Book entries 18
  Expense entries 33
  Mail messages 68
  memos 94
  to do items 134
Entries
  Address Book 2
  beaming 9
  Date Book 18
  Expense 33
  hiding private 127, 129
  memos 94
  showing private 130
  To Do List 134
Event
  changing to untimed 21
  conflicts 28
  date 20
  Date Book scheduling 18
  deleting 25
  in week view 27
  private 25
  repeat 23
  setting alarm 22
  start and duration 18
  untimed 18, 21
Expense
  attendees 37
  categories 36
creating item 33
currency list 38
custom currency 45
custom report 147
default currency 45
details 35
features 33
item currency 36
item date 35
menu commands 44
opening 33
receipt details 35
show options 38
spreadsheet 41
templates 43, 143
type 36
vendor 37
viewing data 39

G
General Preferences
alarm sounds 108
auto-off delay 108
setting date 107
setting time 106
system sounds 108

H
Header Information 67
High Priority
message filter 88
HotSync
button preferences 104
conduits 54
customizing 54
features 47
File Link 61
filtering options 82
first time 48
HotSync Manager 47
local 50
local settings 52
modem 55
modem conduit setup 57
modem settings 53
options 50, 82
user profile 59

I
Idle Timeout 117
Inbox 80
IP Address 117
   automatic setting 119

K
Keyboard
   pen stroke 103

L
Login Script 120
Look Up
   Address Book entries 5

M
Mail
   address lookup 70
   blind copy 73
   changing setup 65
   confirmations 75
   creating 68
custom filter settings 86  
deleting messages 78  
desktop configuration 63  
draft messages 77  
edit unsent messages 76  
features 63  
filing messages 78  
filtering options 82  
filters 84  
folders 80  
HotSync options 64, 82  
menu commands 89  
message list options 80  
messages 66  
opening 66  
priority 72  
priority filter 88  
purge messages 79  
recovering deleted 79  
sending messages 75  
show date 80  
signature 74  
sorting 81  
synchronizing 66  
truncating 88  
Menu Commands  
for network 122  
Mail 89  
Menus  
Address Book 10  
Date Book 29  
Expense 44  
Memo Pad 98  
To Do List 139  
Messages 66  
address lookup 70  
bcc 72  
confirm delivery 72  
confirm read 72  
confirmations 75  
creating 68  
deleting 78  
draft 77  
editing unsent 76  
filing 78  
font style 67  
header information 67  
in deleted folder 79  
list options 80  
priority 72  
purging deleted 79  
sending 75  
show date 80  
signature 72, 74  
sorting 81  
truncating 88  
Memo  
arranging in list 95  
categories 96  
creating new 94  
deleting 97  
private 96  
reviewing memos 94  
Memo Pad  
arranging memos 95  
creating memo 94  
features 93  
menu commands 98  
opening 93  
Memory  
calculator 14  
purge date book 44  
purge to do list 140  
Modem  
HotSync 55  
Modem Preferences 109  
Month  
Date Book view 28  
Network  
connecting 116  
connection type 117  
idle timeout 117  
login script 120  
menu commands 122
password 112
phone settings 113
preferences 110
primary DNS 118
secondary DNS 118
selecting service 110
TCP/IP 110
user name 111
New
Address Book entry 2
Expense item 33
Graffiti shortcut 125
memo 94
messages 68
to do item 134
O
Opening
Address Book 1
Outbox 80
Owner Preferences 124
P
Palm Desktop
configuring mail 63
customizing HotSync 54
File Link 61
HotSync options 50
modem conduit setup 57
synchronization 47
Palm III
assigning password 128
changing password 131
common data 59
deleting password 131
forgotten password 132
HotSync via modem 56
locking with password 130
sound settings 108
Password
assigning 128
changing 131
deleting 131
for network 112
forgotten password 132
locking Palm III 130
with owner preferences 124
Payment
Expense item 36
Pen
preferences 102
Phone Numbers
choosing type 6
Phone Settings 113
call waiting 114
using calling card 115
Power Off
pen stroke 104
PPP 117
Preferences
button 102
Digitizer 105
features 101
Format 105
general 106
HotSync buttons 104
modem 109
network settings 110
opening 101
owner 124
Shortcut 125
Primary DNS 118
Printing
expense reports 40
Priority 72
setting 72
to do item 134
Private
assigning password 128
events 25
memos 96
Private entries
hiding records 129
showing 130
Profiles 59

Index
<table>
<thead>
<tr>
<th>Purge</th>
<th>ShortCuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>date book events 44</td>
<td>deleting 126</td>
</tr>
<tr>
<td>deleted messages 79</td>
<td>editing 126</td>
</tr>
<tr>
<td>to do items 140</td>
<td>Show Date 80</td>
</tr>
<tr>
<td><strong>R</strong></td>
<td>Show Options</td>
</tr>
<tr>
<td>Records</td>
<td>To Do List 138</td>
</tr>
<tr>
<td>Address Book 2</td>
<td><strong>S</strong></td>
</tr>
<tr>
<td>beaming 9</td>
<td>Secondary DNS 118</td>
</tr>
<tr>
<td>Date Book 18</td>
<td>Security</td>
</tr>
<tr>
<td>Expense 33</td>
<td>assigning password 128</td>
</tr>
<tr>
<td>hiding private 127, 129</td>
<td>changing password 131</td>
</tr>
<tr>
<td>showing private 130</td>
<td>deleting password 131</td>
</tr>
<tr>
<td>To Do List 134</td>
<td>features 127</td>
</tr>
<tr>
<td>Recovering</td>
<td>forgotten password 132</td>
</tr>
<tr>
<td>deleted mail 79</td>
<td>hiding records 129</td>
</tr>
<tr>
<td>filed mail 78</td>
<td>locking Palm III 130</td>
</tr>
<tr>
<td><strong>R</strong></td>
<td>opening 127</td>
</tr>
<tr>
<td>Removing</td>
<td>showing records 130</td>
</tr>
<tr>
<td>Address Book entries 4</td>
<td></td>
</tr>
<tr>
<td>Date Book events 25</td>
<td></td>
</tr>
<tr>
<td>memos 97</td>
<td></td>
</tr>
<tr>
<td><strong>S</strong></td>
<td></td>
</tr>
<tr>
<td>Secondary DNS 118</td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td></td>
</tr>
<tr>
<td>TCP/IP 110</td>
<td>Templates</td>
</tr>
<tr>
<td>Templates</td>
<td>expense report 43</td>
</tr>
<tr>
<td>expense report 143</td>
<td></td>
</tr>
<tr>
<td><strong>T</strong></td>
<td>Time</td>
</tr>
<tr>
<td><strong>T</strong></td>
<td>alarm setting 22</td>
</tr>
<tr>
<td>Service</td>
<td>format 106</td>
</tr>
<tr>
<td>Service Templates 116</td>
<td>setting 106</td>
</tr>
<tr>
<td>deleting 122</td>
<td>setting event 18</td>
</tr>
<tr>
<td>ShortCut</td>
<td></td>
</tr>
<tr>
<td>preferences 125</td>
<td>To Do List</td>
</tr>
<tr>
<td>categories 136</td>
<td>checking off item 135</td>
</tr>
<tr>
<td>completion date 139</td>
<td>creating item 134</td>
</tr>
<tr>
<td>deleting items 137</td>
<td>deleting items 137</td>
</tr>
<tr>
<td>features 133</td>
<td>deleting items 137</td>
</tr>
<tr>
<td>item details 136</td>
<td>item details 136</td>
</tr>
<tr>
<td>item due date 136</td>
<td>item due date 136</td>
</tr>
<tr>
<td>item priority 134</td>
<td>item priority 134</td>
</tr>
<tr>
<td>menu commands 139</td>
<td>menu commands 139</td>
</tr>
<tr>
<td>opening 133</td>
<td>menu commands 139</td>
</tr>
<tr>
<td>show due items 138</td>
<td>show due items 138</td>
</tr>
<tr>
<td>show options 138</td>
<td>show options 138</td>
</tr>
<tr>
<td>Truncate 88</td>
<td></td>
</tr>
</tbody>
</table>
U
Untimed Events 18, 21
User Name
  for ISP 111
User Profile 59
V
Vendor 37
W
Week
  Date Book view 26